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Welcome...

Welcome to the user guide for the PC operator application MiVoice 1560 
PC Operator for MiVoice Office 400 communication systems.

This user's guide will assist you with the use of your MiVoice 1560 PC 
Operator and introduce you step by step to the functions and configura-
tion. If you require further technical support or information on other prod-
ucts of Mitel please visit our website www.mitel.com or use our Mitel Doc-
Finder.

Notes: • Not all listed functions are available by default. Contact your system 
administrator to learn more about the available features and services in 
the MiVoice Office 400 communication system.

• Your system administrator has the option to individually set some of the 
application's features. In this case your default values will differ from the 
default values described in this user's guide.

• You can couple MiVoice 1560 as rich client version with various Mitel 
phones. Note that the operation may depend on the coupled Mitel 
phone (see also "Calling via Mitel phone", page 24).

• If your MiVoice 1560 as rich client version is coupled with a Mitel SIP 
phone, your Mitel SIP phone may have only 1 line. This setting is made 
by your system administrator.
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Product and safety informa-
tion, legal information

The product and safety information is available here. 
You will also find notes on data protection and legal 
information.

Please read through this product and safety informa-
tion carefully. 

About Mitel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5
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About Mitel
Mitel® (Nasdaq:MITL) (TSX:MNW)is a global leader in business communi-
cations that easily connect employees, partners and customers - any-
where, anytime and over any device, for the smallest business to the larg-
est enterprise. Mitel offers customers maximum choice with one of the 
industry’s broadest portfolios and the best path to the cloud. With more 
than US$1 billion in combined annual revenue, 60 million customers world-
wide, and #1 market share in Western Europe, Mitelis a clear market 
leader in business communications. For more information, go to 
www.mitel.com.

About MiVoice Office 400

Purpose and function
This product is part of the MiVoice Office 400 communication solution.

The software can only be launched if a communication server, configured 
accordingly, is detected.

MiVoice 1560 can be used as an operator console on a stand-alone sys-
tem or in a networked environment with several systems. Besides the wide 
array of telephone operator functions, the application also provides all the 
user-friendly phone functions required for personal use.

MiVoice Office 400 is an open, modular and comprehensive communica-
tion solution for the business sector with several communication servers of 
different output and expansion capacity, a comprehensive telephone port-
folio and a multitude of expansions. They include an application server for 
Unified Communications and multimedia services, an FMC (Fixed Mobile 
Conversion) controller for integrating mobile phones, an open interface for 
application developers and a multitude of expansion cards and modules.

The business communication solution with all its components was devel-
oped to cover in full the communication requirements of businesses and 
organisations, in a way that is both easy to use and maintenance-friendly. 
The individual products and components are coordinated and must not be 
used for other purposes or replaced by third-party products or components 
(unless it is to connect other approved networks, applications and tele-
phones to the interfaces certified specially for that purpose).
MiVoice 1560 PC Operator 5
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User information
All user documents are available for download from the  Mitel DocFinder 
as individual documents or as documentation sets. It is your responsibility 
to keep up to date with the scope of functions, the proper use and the 
operation of your product.

The user's guide of the application is available as a PDF version and as 
online version. For the online version press the F1 key if needed.

• Please make sure you have all the user documents required to operate 
your product efficiently and correctly.

• Make sure that the versions of the user documents comply with the soft-
ware level of the MiVoice Office 400 products used and that you have 
the latest editions.

• Always read the user documents first before you put your product into 
operation.

• Store the user information within easy reach and refer to it whenever 
uncertainties arise in connection with the use of the product.

• When handing over your product to others, make sure you enclose the 
relevant user information.

Download MiVoice Office 400 documents from the internet: 
www.mitel.com/docfinder.

Availability
The availability of the application depends on a functioning PC with power 
supply, and the availability of the data network and the communication 
server (including OIP server). If the application is not available, calls are 
displayed on the coupled phone (Rich client version) or routed to a substi-
tute destination set by your system administrator (IP version).

Data protection

Protection against listening in and recording
The MiVoice Office 400 communication solution comprises features which 
allow calls to be monitored and recorded without the call parties noticing. 
Please note that these features can only be used in compliance with 
national data protection provisions.
6 MiVoice 1560 PC Operator
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Limited Warranty (Australia only)
The benefits under the Mitel Limited Warranty below are in addition to 
other rights and remedies to which you may be entitled under a law in rela-
tion to the products.

In addition to all rights and remedies to which you may be entitled under 
the Competition and Consumer Act 2010 (Commonwealth) and any other 
relevant legislation, Mitel warrants this product against defects and mal-
functions in accordance with Mitel's authorized, written functional specifi-
cation relating to such products during a one (1) year period from the date 
of original purchase ("Warranty Period"). If there is a defect or malfunction, 
Mitel shall, at its option, and as the exclusive remedy under this limited 
warranty, either repair or replace the product at no charge, if returned 
within the warranty period.

Repair Notice
To the extent that the product contains user-generated data, you should be 
aware that repair of the goods may result in loss of the data. Goods pre-
sented for repair may be replaced by refurbished goods of the same type 
rather than being repaired. Refurbished parts may be used to repair the 
goods. If it is necessary to replace the product under this limited warranty, 
it may be replaced with a refurbished product of the same design and col-
our.

If it should become necessary to repair or replace a defective or malfunc-
tioning product under this warranty, the provisions of this warranty shall 
apply to the repaired or replaced product until the expiration of ninety (90) 
days from the date of pick up, or the date of shipment to you, of the 
repaired or replacement product, or until the end of the original warranty 
period, whichever is later. Proof of the original purchase date is to be pro-
vided with all products returned for warranty repairs.

Exclusions
Mitel does not warrant its products to be compatible with the equipment of 
any particular telephone company. This warranty does not extend to dam-
age to products resulting from improper installation or operation, alteration, 
accident, neglect, abuse, misuse, fire or natural causes such as storms or 
floods, after the product is in your possession. Mitel will not accept liability 
for any damages and/or long distance charges, which result from unau-
thorized and/or unlawful use.
MiVoice 1560 PC Operator 7
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To the extent permitted by law, Mitel shall not be liable for any incidental 
damages, including, but not limited to, loss, damage or expense directly or 
indirectly arising from your use of or inability to use this product, either 
separately or in combination with other equipment. This paragraph, how-
ever, is not intended to have the effect of excluding, restricting or modifying 
the application of all or any of the provisions of Part 5-4 of Schedule 2 to 
the Competition and Consumer Act 2010 (the ACL), the exercise of a right 
conferred by such a provision or any liability of Mitel in relation to a failure 
to comply with a guarantee that applies under Division 1 of Part 3-2 of the 
ACL to a supply of goods or services.

This express warranty sets forth the entire liability and obligations of Mitel 
with respect to breach of this express warranty and is in lieu of all other 
express or implied warranties other than those conferred by a law whose 
application cannot be excluded, restricted or modified. Our goods come 
with guarantees that cannot be excluded under the Australian Consumer 
Law. You are entitled to a replacement or refund for a major failure and for 
compensation for any other reasonably foreseeable loss or damage. You 
are also entitled to have the goods repaired or replaced if the goods fail to 
be of acceptable quality and the failure does not amount to a major failure.

Warranty Repair Services
Procedure: Should the product fail during the warranty period and you 
wish to make a claim under this express warranty, please contact the Mitel 
authorized reseller who sold you this product (details as per the invoice) 
and present proof of purchase. You will be responsible for shipping 
charges, if any.

Limitation of liability for products not of a kind ordinarily acquired for per-
sonal, domestic or household use or consumption (e.g. goods/services 
ordinarily supplied for business-use).

1.1 To the extent permitted by law and subject to clause 1.2 below, the liability 
of Mitel to you for any non-compliance with a statutory guarantee or loss or 
damage arising out of or in connection with the supply of goods or services 
(whether for tort (including negligence), statute, custom, law or on any other 
basis) is limited to:
a) in the case of services:

i) the resupply of the services; or
ii) the payment of the cost of resupply; and

b) in the case of goods:
i) the replacement of the goods or the supply of equivalent goods; or
ii) the repair of the goods; or
8 MiVoice 1560 PC Operator
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After Warranty Service
Mitel offers ongoing repair and support for this product. If you are not oth-
erwise entitled to a remedy for a failure to comply with a guarantee that 
cannot be excluded under the Australian Consumer Law, this service pro-
vides repair or replacement of your Mitel product, at Mitel's option, for a 
fixed charge. You are responsible for all shipping charges. For further 
information and shipping instructions contact:

iii) the payment of the cost of replacing the goods or of acquiring equiv-
alent goods; or

iv) the payment of the cost of having the goods repaired.
1.2 Clause 1.1 is not intended to have the effect of excluding, restricting or 

modifying:
a) the application of all or any of the provisions of Part 5-4 of Schedule 2 to 

the Competition and Consumer Act 2010 (the ACL); or
b) the exercise of a right conferred by such a provision; or
c) any liability of Mitel in relation to a failure to comply with a guarantee that 

applies under Division 1 of Part 3-2 of the ACL to a supply of goods or 
services.

Manufacturer: Mitel South Pacific Pty Ltd ("Mitel")
Level 1, 219 Castlereagh Street
Sydney, NSW2000, Australia
Phone: +61 2 9023 9500

Caution:
Repairs to this product may be made only by the manufacturer and its 
authorized agents, or by others who are legally authorized. Unauthor-
ized repair will void this express warranty.
MiVoice 1560 PC Operator 9
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Regulatory provisions

CE conformity
Mitel Schweiz AG hereby declares that the MiVoice Office 400 products

• conform to the basic requirements and other relevant provisions of the 
Directive EMC (2014/30/EU) and LVD (2014/35/EU).

• are manufactured in conformity with RoHS according to the Directive 
2011/65/EU.

The product-specific declarations of conformity can be found on the follow-
ing website: www.mitel.com/regulatory-declarations.

Document information
• Document number: eud-1683
• Document version: 1.1

• Based on: MiVoice Office 400 OIP R8.6.1
• Valid as of: MiVoice Office 400 OIP R8.6.0
• In PDF Viewer, click on this link to download the latest version of this 

document:
https://pbxweb.aastra.com/doc_finder/DocFinder/eud-1683_en.pdf?get&DNR=eud-1683

• Copyright © 07.2016 Mitel Networks Corporation
10 MiVoice 1560 PC Operator
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Integration of MiVoice 1560

The following sections explain the necessary steps you 
need to take to comfortably integrate MiVoice 1560 in 
your everyday business life.

Using MiVoice 1560. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Starting MiVoice 1560 . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Setting up MiVoice 1560 . . . . . . . . . . . . . . . . . . . . . . . . . 17

Exit MiVoice 1560 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
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Using MiVoice 1560
Using an MiVoice 1560 offers many advantages for operators: Call transfer 
using the mouse, indication of the internal users available, interactive 
queue for calls pending, quick and convenient dialling by name, simple 
handling of call lists, unlimited number of contacts, synchronization with a 
Microsoft Exchange server, direct access to contact databases, to mention 
but a few. At the same time you also have access to all the added features 
of Mitel phones, with the high standard of quality you have come to expect.

And of course the MiVoice 1560 can also be used as a personal tele-
phone.

MiVoice 1560 can be used in two versions:

Rich client version: MiVoice 1560 in the rich client version is an applica-
tion for operator consoles which, with its user-friendly interface, sets the 
standard for a versatile and modern operator workstation. It integrates ide-
ally into the Office PC environment and considerably broadens the scope 
of functions of the coupled Mitel phones.

IP version: MiVoice 1560 as IP softphone is a full fledged PC phone that 
is not coupled to a physical phone (hardphone). The media devices are 
installed on the PC.

Regardless of whether you use MiVoice 1560 as a rich-client application 
together with a Mitel phone or with a PC media device via the IP network: 
You will undoubtedly appreciate the versatile features. The PC monitor 
tells you at a glance who is calling, who internally is busy or absent, and 
who has forwarded their phone. If there are several calls waiting, you can 
select the most important call directly. If users are busy, you can dial their 
substitution, leave a text message on the phone or send an e-mail. When 
connected with Microsoft Exchange you also have access to calendar 
information and absence information when it comes to forwarding calls.

MiVoice 1560 runs on the Mitel Open Interfaces Platform (OIP). The Mitel 
Open Interfaces Platform (OIP) is the interface between the Mitel commu-
nication server and applications (Mitel applications and third-party applica-
tions) and guarantees a seamless integration of CTI applications.

Note: Deactivate the screen saver on computers with the installed  
MiVoice 1560: Using an MiVoice 1560on a computer with deactivated 
screen saver may lead to an unwanted behaviour when an incoming  is 
displayed. 
14 MiVoice 1560 PC Operator
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Media device for MiVoice 1560
Your system administrator has equipped your application with a media 
device. Depending on the media device used, the operation of the device 
may vary slightly from the instructions given here.

Rich client version: The media device is a cordless or corded MiVoice 
Office 400 phone used as a speaking and listening device. Acoustic call 
signalling takes place on MiVoice 1560, only acoustic call signalling for 
calls to the personal call number takes place on the coupled phone.

IP version: The media device may be a phone handset or headset con-
nected directly to the PC. Only use the media devices specifically recom-
mended by the manufacturer.
MiVoice 1560 PC Operator 15
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Starting MiVoice 1560
The application is installed by your system administrator so that it starts 
automatically whenever you start your PC. You can also start the applica-
tion manually by double-clicking the program icon  on your desktop. 
Contact your system administrator for more information.

The system constantly checks whether the latest application software ver-
sion is available. If not, the program is automatically updated.

Using MiVoice 1560 on different workstations
You can set up your MiVoice 1560 on several PCs. Calls are then automat-
ically routed to the PC you are currently using. Do you sometimes work in 
a branch? As soon as you start MiVoice 1560, calls are offered there auto-
matically.

Starting MiVoice 1560:
Double-click the  icon on your Desktop. If required, enter your password and 
confirm with Ok.
➯MiVoice 1560 is started.

If you are starting MiVoice 1560 for the first time (if not yet set up by your 
system administrator):
1. Click  or select Tools  > Settings >  Connection.
2. Under Phone number enter your user phone number.
3. Under PIN enter your user PIN.
4. Confirm with Connect.
➯MiVoice 1560 is connected with your phone.

Notes: • The Connection state shows whether connection has been set up correctly.
• For information on connection settings, refer to chapter 

"Settings: Connection", page 20.
16 MiVoice 1560 PC Operator
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Setting up MiVoice 1560
After the application is started, the configuration can be executed via 
the settings menu.

Configuring the settings

Note: MiVoice 1560 can be integrated into a Citrix or terminal server environ-
ment. If your application is integrated into a Citrix or terminal server envi-
ronment, you will find this menu in the context menu of the phone window  
> Settings. Contact your system administrator for more information.

Settings: Operation

1. Click  or select Tools > Settings.
2. Enter the settings you want and click Apply to confirm the changes.

Setting Description

Language Select the language you want; the application lan-
guage change (selected language or language of 
your system, if available) will take effect after restart-
ing.

Missed event ring tone Click  to open the list of available audio files. You 
can listen to the audio files with .

Start automatically with 
Windows

Tick the checkbox if you want the application to open 
automatically with Windows.

Idle timeout Tick the checkbox and the time after which the appli-
cation is to go to idle state.

Default application for 
"callto:" URLs

Tick the checkbox so that "callto:-URLs" on websites 
are opened with the application. The phone number 
in the URL address is dialled directly.

Use default web browser Tick the checkbox so your PC's default web browser 
is used. If the checkbox is unnticked, the application's 
internal web browser window is opened.
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Settings: Hotkeys
Instead of clicking your way through a menu, you want to be able to exe-
cute a function with a hotkey of your choice. This is an efficient way for you 
to carry out recurring actions.

All the functions you can execute using a hotkey were assigned to preset 
combinations. You can edit, delete or reset them to their default values as 
required.

Note: You cannot create any hotkey if MiVoice 1560 is coupled with a Mitel SIP 
phone.

The following choice of hotkey combinations is available:

Hotkey Example

Function key F1 to F12

Control key + digit Ctrl + 3

Control key + letter Ctrl + E

Control key + function key Ctrl + F4

Control key + Shift key + digit Ctrl + Shift key + 3

Control key + Shift key + letter Ctrl + Shift key + E

Control key + Alt key + digit Ctrl + Alt + 1

Click  or select Tools  > Settings > Hotkeys.

Setting up hotkeys:
1. Select the action you want, enter the combination you want in the free field of 

Enter new hotkey and click the Assign button.
2. Confirm with Apply.

Resetting all the hotkeys:
1. Click the Reset all  button to reset the hotkeys to their default settings.
2. Confirm with Apply.

Delete hotkey:
1. Select the action you want and click Delete.
2. Confirm with Apply.
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List of hotkeys
Below is a list of all the functions you can operate using a hotkey. The pre-
set values are shown in column 2. You can reset your values to these 
default settings at any time. In column 3 you can enter your hotkey in the 
input fields and then print out the page.

Function: Open/activate window Default value

Open/activate window: Agent control Ctrl + Shift key + A

Open/activate window: Presence indicator F6

Open/activate window: External display Ctrl + Shift key + E

Open/activate window: Journal F5

Open/activate window: Calendar Ctrl + Shift key + C

Open/activate window: Configuration Ctrl + Shift key + O

Open/activate window: Contact details F8

Open/activate window: Search F4

Open/activate window: Phone book F7

Open/activate window: Phone window F2

Open/activate window: Dial pad Ctrl + F2

Open/activate window: Call queue F3

Function: Miscellaneous Default value

Activate/restore MiVoice 1560 F12

Dial selected number Ctrl + F12

Mute/unmute microphone Ctrl + M

Function: Phone window Default value

Phone window: End active call Ctrl + E

Phone window: Park active call Ctrl +  P

Phone window: Transfer active call Ctrl +  T

Phone window: Reject incoming call Ctrl +  X

Phone window: Answer incoming call Ctrl +  A

Phone window: Deflect incoming call Ctrl +  D

Phone window: End call Ctrl +  H

Phone window: Unpark parked call Ctrl + U

Phone window: Conference Ctrl + C
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Settings: Connection
Your connection data for the OIP server, phone number and user PIN, 
which your office administrator has already set up, are stored here. Con-
tact your system administrator for more information.

Phone window: Brokering Ctrl + B

Phone window: Write note to active call Ctrl + N

Phone window: Enquiry call Ctrl + Q

Phone window: Activate ring tone on active call Ctrl + O

Phone window: Open redial list Ctrl + R

Function: Call queue Default value

Call queue: Unpark first external parked call Ctrl + Alt + 1

Call queue: Unpark first internal parked call Ctrl + Alt + 2

Call queue: Answer first external call Ctrl + 1

Call queue: Answer first internal call Ctrl + 2

Call queue: Seize line for external call Ctrl + Shift key + 1

Call queue: Seize line for internal call Ctrl + Shift key + 2

Setting Description

• Server address
• IIOP port
• HTTP port

Enter here the host name or IP address of the OIP 
server.

Use Windows login name Tick the checkbox if a corresponding OIP user with 
the same name is open. The system then automati-
cally selects the coupled phone.

• Phone number
• PIN

Enter username and PIN.

Save PIN Tick the checkbox to ensure you are no longer 
prompted for the password when you restart the 
application.

Call connection status Indicates the current call connection status of the 
application.

Select telephony line Select the relevant telephony line.

Function: Phone window Default value
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Note: You may couple MiVoice 1560 with all Mitel phones. For further informa-
tion refer to Chapter "Calling via Mitel phone", page 24.

Settings: Outlook
Local Outlook integration (Microsoft Exchange synchronisation): 
Mitel Open Interfaces Platform (OIP)supports the integration of an Micro-
soft Exchange server for directory synchronization. Moreover, for local 
Outlook integration, personal Outlook address books are synchronized 
with private OIP directories. Contact your system administrator for more 
information.

Select from the following settings:

Apply phone selection 
from OIP

Tick the checkbox if the selection is to be made 
according to the OIP user profile. Contact your sys-
tem administrator for more information.

Select phone Select the phone you want.

Setting Description

Setting Description

Enable local Outlook synchro-
nisation

Tick the checkbox and answer the security ques-
tion to make the synchronization settings you 
want between Outlook and MiVoice 1560.

Use Outlook profile Select the Outlook profile you want.

Synchronisation period Manual or automatically after time.

Hotkey to launch synchronisa-
tion

Select the hotkey you want to use to start the syn-
chronization.

Synchronisation contents:
• Synchronise contacts
• Synchronise calendar

Select one or both options. Click the  button to 
select a folder.
Tick the checkbox Include subfolders in the 
popup window to enable the synchronisation of 
all subfolders of the selected folder.

Note: Only private folders can be synchronized.
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Set-up possibilities and their impacts:

Settings: Logging
You can specify the Log level for which a log file is to be written. Contact 
your system administrator for more information.

Synchronisation direction: Description

Update Outlook data to 
MiVoice 1560  (Default)

Manual changes to Outlook appointments and to 
the presence status in MiVoice 1560 are synchro-
nized in the communication server and displayed 
on the coupled phone.

Update MiVoice 1560 data to 
Outlook data

Update in both directions Manual changes to Outlook appointments and to 
the presence status in MiVoice 1560 are synchro-
nized in the communication server and displayed 
on the coupled phone.
Moreover, manual changes to the presence status 
on the coupled phone are adopted in OIP and syn-
chronised in Outlook.
Changing the presence status on the coupled 
phone manually to Available also ends all active 
appointments in Outlook.

Setting up synchronization:
1. Click  or select Tools > Settings > Outlook.
2. Tick Enable Outlook synchronisation to activate the synchronization between 

Outlook and MiVoice 1560.
➯You can select the Outlook profile you want, depending on the user rights 

given to you by the system administrator.
3. Select the synchronisation settings you want and click Apply to confirm.
➯MiVoice 1560 and Outlook will be synchronized according to your settings.

Starting the synchronization manually:
Click  or select Tools >  Sync with Outlook now.
➯Manual synchronisation of Outlook and MiVoice 1560 is now triggered.

Synchronization report:
Click  or select Tools >  View sync report.
➯Last synchronisation is displayed.
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Settings: E-mail

Note: You can use a lot of variables for e-mail transmission, and configure a pre-
set standard e-mail.

Settings: contact

Help
Should you have further questions - the MiVoice 1560 help offers you 
advice and assistance. Choice available to call the help:

Setting Description

Default e-mail application If activated, e-mails are by default sent via Outlook.

Default e-mail with call 
information

You can send an e-mail with the latest call informa-
tion. The e-mail text can be edited.

Setting Description

Custom field labels Define your own customer fields.

Press the F1 key.
Or:
Select Help > Help.
Or:
Open the context menu of a window and select Help.
➯The Help opens in a new web browser window.
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Calling via Mitel phone
You can couple your MiVoice 1560 with the following Mitel phones:

• Mitel SIP phones
• Mitel 600 SIP-DECT phones

• MiVoice 5300 / 5300 IP phones
• MiVoice 2380 IP softphone
• Mitel 600 DECT phones

When your system administrator has set up your MiVoice 1560 and Mitel 
phone, you can connect and use MiVoice 1560 together with  the Mitel 
phone (see Chapter "Starting MiVoice 1560", page 16). Make all audio set-
tings in the Mitel phone.

As soon as the application and phone are installed and set up, you can 
start MiVoice 1560 (MiVoice 2380 IP automatically opens at the back-
ground). You can now make you calls comfortably via the application  and 
use all application functions.

Exit MiVoice 1560
You want to close the application.

Note: If the application is not available or if the application is closed, calls are dis-
played on the coupled phone (Rich client version) or routed to a substitute 
destination set by your system administrator (IP version).

End MiVoice 1560:
Close the application using the  button or select File  > Exit.
➯The application is closed.
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Display symbols, operation

Find out how to customise the look & feel and the set-
tings of your MiVoice 1560 in the following sections.

Operating and display elements  . . . . . . . . . . . . . . . . . . . 26

Using the display and operating elements. . . . . . . . . . . . 30

Audio settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

Telephony settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

Window settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Printing lists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

Contact details. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
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Operating and display elements

User console operating elements

No. Key Description

1 Phone window Left: Active call window.
Right: Enquiry call window.

2 Call queue

3 Search

4 Journal

5 Presence indicator

6 Contact details

7 Symbol bar
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Display symbols

Toolbar functions

Note to active call

Activate/deactivate acoustic signalling

Settings

Operator groups

Company A or Company B1)

Log agent in to all operator console groups

Log agent out of all operator console groups

Activate agent pause

Deactivate agent pause

Agent status: Pause inactive (if agent is logged out)

Agent in wrap up mode

Activate/deactivate substitution for PC operator consoles

1) If MiVoice 1560 is integrated into a two-company configuration.
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Call forwarding display symbols

No forwarding, forward on busy or on no reply

Call forw. (CFU) to user

Call forw. (CFU) to voice mail

Call forw. (CFU) to cordless phone

Call forw. (CFU) to text message

Destination: Operator console1)

Call forw. (CFU) to Do not disturb

1) If MiVoice 1560 is configured as a member of an operator console group.

Phone status display symbols

Available

Busy

Meeting

Absent

Not available

Unknown

Profile display symbols

No active profile

Profile activated

Activated profile with changes
28 MiVoice 1560 PC Operator
eud-1683_en/1.1 – OIP R8.6.1 – 07.2016



 Display symbols, operation

eud-1683_en.book  Page 29  Friday, July 8, 2016  5:33 PM
Phone window display symbols

Missed (unanswered) calls

New voice message

New text messages

Redial

Microphone deactivated

Microphone activated

Loudspeaker activated

Call connection states display symbols

Incoming internal call

Incoming internal call connected

Incoming external call

Incoming external call connected

Outgoing internal call

Outgoing internal call in a call

Outgoing external call

Outgoing external call in a call

Outgoing internal/external call busy

Internal/external recall

Parked call

Call on hold

Call transferred
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External display
You can also display on your PC screen alarm messages displayed on 
your phone display.

You can choose a different ring tone for each alarm message (for example 
alarm, urgent, message). Information is displayed on the phone according 
to the defined priority. The priority settings are part of the display profile 
(see Chapter "Notification profiles", page 113).

Using the display and operating elements
The following sections explain how to operate your MiVoice 1560 
quickly and simply.

User console
All the windows and functions are to be found in the main user console of 
MiVoice 1560. From the console you can use your PC keyboard to take 
calls from the queue, make your own personal calls, carry out the configu-
ration, and operate the journal, phone book and presence indicator.

You can customise the look & feel of the user console to suit your require-
ments. All the setting possibilities are described in Chapter "Adjusting the 
layout", page 35.

Company A1)

Company B1)

1) Displayed only if MiVoice 1560 is part of a two-company configuration.

Call connection states display symbols

Open the External display.

Open the context menu and select Settings.

Select the settings you want and click OK to confirm.
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Frequently used functions are operated with the mouse via the 
MiVoice 1560 (see Chapter "User console operating elements", page 26).

The status field displays the status of switching groups and other functions 
such as substitute circuits or call diversions.

Keyboard operation
To scroll in the menus, use your application buttons, your PC keyboard or 
your mouse. Select an entry by double-clicking or using the Enter key.

Menu bar Description

File • Opens the Print menu (see Chapter "Printing lists", 
page 37).

• Exits the application.

Telephony All phone settings (example: operator consoles, call for-
warding, notifications).

Groups1)

1) If MiVoice 1560 is configured as a member of an operator console group.

• Operator groups.
• Login or pause.

Tools • Opens the Settings menu (see Chapter "Setting up 
MiVoice 1560", page 17).

• Starts the Outlook synchronization (see Chapter 
"Settings: Outlook", page 21).

Window • Selects all the windows to be displayed.
• Layout menu (see Chapter "Adjusting the layout", 

page 35).

Help Opens the Help window (see Chapter "Help", page 23).

PC keyboard Description

Enter key 
(Enter/Return)

• Confirms your input.
• In the phone window:

– Enter phone number and press Enter key.
– End call.

Navigation keys Selects the entry.
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Audio settings
Here you can select the ring device you want, the ring melody for 
internal and external calls, and the voice output settings.

Activate/deactivate acoustic signalling
You can activate or deactivate the acoustic signal as required.

Ring output (rich client version only)
If you are running the operator application as an IP softphone, indicate the 
installed output devices and select the audio files for signalling calls or sys-
tem messages.

Calls can ring on the internal PC speaker, the media device or another 
connected speaker (external speaker).

Acoustic signal off:
Click on .
Or:
Select Tools  > Acoustic signal off.
➯The acoustic signal is deactivated;  is displayed.

Activate acoustic signal:
Click on .
Or:
Select Tools  > Acoustic signal off.
➯The acoustic signal is activated;  is displayed.

Open the Phone window.

Open the context menu and select Ring output.

Click  to open the list of available audio files. You can listen to the audio files 
with .
Click Apply to confirm the selection.
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Voice output settings (IP version only) 
Your system administrator has equipped your PC with a media device. 
This could be a handset, a headset or a Bluetooth device. Depending on 
the device, the operation of your media device may differ slightly from 
these instructions. Ask your system administrator to explain the correct 
operation in each case.

Select your input and output device and the corresponding settings. In 
most cases, your system administrator will have already made these set-
tings for the media devices you use.

Setting Description

AGC (automatic gain 
control)

Your voice on the microphone is automatically amplified 
if you are speaking quietly or the microphone is further 
away (Automatic Gain Control).

AEC (automatic echo 
cancellation)

Switch on, when your call parties can hear the echo of 
their own voice (Automatic Echo Cancellation).

Noise reduction Reduces the noise levels.

Passband filter Only audio signals of a certain area are able to pass, 
audio signals outside this area (high, deep) are attenu-
ated.

VAD (voice activity 
detection)

When switched on, no data is sent over the network 
when the microphone receives no sound. Without Voice 
Activity Detection data is continuously sent, even when a 
person is not speaking (Voice Activity Detection).

Direct sound When switched on, the application can directly use the 
audio hardware of the system, thus accelerating the 
speed and reducing the amount of computer power 
needed to process the sound data.

Open the Phone window.

Open the context menu and select Voice output.

Select the settings you want and click Apply to confirm.
MiVoice 1560 PC Operator 33
eud-1683_en/1.1 – OIP R8.6.1 – 07.2016



 Display symbols, operation

eud-1683_en.book  Page 34  Friday, July 8, 2016  5:33 PM
Telephony settings
You can carry out your telephony settings after starting the applica-
tion.

General tab

Dialling by name tab
In this tab, highlight the phone books for the search and the number of 
search results.

Setting Description

Identify external num-
bers

Tick the checkbox so that external numbers are auto-
matically recognised as external call numbers in the 
case of an outgoing call. Use either the system settings 
or enter the number of digits you want.

Show CDE informationTick the checkbox so that an external call coming in via 
a call distribution element (CDE) is displayed.

Open the Phone window.

Open the context menu and select Telephony settings.

Select the General  tab. 

Select the settings you want and click Apply to confirm.

Setting Description

Use dialling by name Check if you wish to search or dial by names in the 
phone window.

Show search results Number of results on one page.

Open the Phone window.

Open the context menu and select Telephony settings.
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Window settings
You want to adapt the window settings to your personal needs.

You can show or hide windows and arrange them to suit your needs. 
Within the windows you can specify which information should be dis-
played. You can define several layouts and use the appropriate one 
as required.

Selecting windows
The Window  menu provides all the windows of the MiVoice 1560, all of 
which you can also open using a hotkey (see Chapter "Settings: Hotkeys", 
page 18).

You can select many settings and actions by opening the context menu 
with a right-click and selecting the corresponding menu.

Adjusting the layout
You can adjust the design of your MiVoice 1560 to suit your needs.

Select the Name dialling tab. 

Select the settings you want and click Apply to confirm.

Column setting Description

Column width Use the mouse to drag the right column edge.

Column sequence Click the header of the column you want and drag it to 
the desired location.

Alignment Align left, Align right, Align centre

Best fit The column width automatically adapts to the largest 
entry.
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Selecting a column, sorting a list
In each window with tables you can select those columns that are to be 
displayed.

You can sort all the lists: Click the column header once to sort in ascending 
order and a second time to sort in the opposite order.

Save layout:
1. Design MiVoice 1560 to suit your requirements.
2. Select Window > Layouts > Save layout.
3. Assign a name to the current layout and click Save.

Restore layout:
1. Select Window > Layouts > Restore layout.
2. Select the layout you want and click on Load.
➯MiVoice 1560 is loaded with the new layout.

Delete layout:
1. Select Window > Layouts > Delete layout.
2. Select the layout you want and click on Delete.
3. Answer Yes to the security question.

Open the window you want.

Click the table and right-click to open the context menu.

Select columns:
1. Select the Select columns button. 
2. Select the settings you want in the sequence you want and click OK to con-

firm.
➯The columns are displayed.

Sorting lists:
click the column header once. 
➯The columns are sorted in ascending order.
Click the column header a second time. 
➯The columns are sorted in descending order.
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Select font
You can select a specific font for each table.

Printing lists
You can print out individual or summary lists on a user or a particular 
window.

Printing a user list
You can print all the entries of the users in your communication system 
summarised on a single list.

Open the window you want.

Click the table and right-click to open the context menu.

Select font:
1. Select the Select font button. 
2. Select the font, font style and font size you want then click OK to confirm.
➯The table is displayed in the new font.

Reset font:
Select the Reset font button. 
➯The table is displayed in the standard font.

Select File > Print > User list.
➯The list of all the users is displayed in the print preview.

Select Print and your printer with the settings you want.
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Printing an absence list
You can print the absence entries of all the users in your communication 
system summarised on a single list.

Information about the time frame:

• If you do not enter a start date, all the days up to the entered end date 
are taken into account.

• If you do not enter an end date, all the days from the start date are 
taken into account.

• If you do not enter a start time, the time 00:00 is used.
• If you do not enter an end time, the time 24:00 is used.

Printing the journal
You can print all your journal entries (missed calls, answered calls, redial 
list, text messages, voice messages) summarised on a single list.

Select File > Print > Absence list and the period you want (date and time).
➯The list of all absence entries is displayed in the print preview.

Select Print and your printer with the settings you want.

Select File > Print > Journal.
➯The journal is displayed in the print preview.

Select Print and your printer with the settings you want.
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Printing user data
You can print various information about a user contact in your 
MiVoice 1560 summarised on a single list. The following information on a 
user contact is available to you:

• General information (user data)

• Journal
• Notes (text messages/notes)
• Absences

Contact details

Displaying information about a contact
You want to know at a glance all the details you have about a contact?

You can display all the available information about a user with a single 
click.

The corresponding journal and calendar entries are also displayed in the 
case of OIP users.

Select a user contact from a list.

Select File > Print > User data and the setting you want.
➯The list is displayed in the print preview.

Select Print and your printer with the settings you want.

Select a user contact from the window Search or Phone book.
➯All information about this contact is displayed in the Contact details > Gen-

eral/Journal/Calender window.
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Phoning

The following sections explain the setting and opera-
tion possibilities of your operator application.

Call queue settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41

Working in direct mode  . . . . . . . . . . . . . . . . . . . . . . . . .  43

Substitution  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44

Phoning on the queue . . . . . . . . . . . . . . . . . . . . . . . . . .  45

Phoning with a personal call number . . . . . . . . . . . . . . .  50
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Call queue settings
With an operator application several calls can be received at the same 
time without it being Busy. The calls are offered in the queue. Double-click-
ing lets you answer a waiting call even if it is not the first call in the queue.

You can also use the queue to set up an internal or an external call. To do 
so, right-click a blank line and select whether you want to set up an internal 
or an external call.

Note: If the queue is neither available nor closed, incoming calls cannot be sig-
nalled to the queue.

Select from the following queue settings:

Incoming call Description

Call type You have the following call types available:
• Internal call (call queue)
• External call (call queue)
• External call for company A (call queue)
• External call for company B (call queue)
• Internal call to active group (call queue)
• Internal call to inactive group (call queue)
• External call to active group (call queue)
• External call to inactive group (call queue)

Ring tone For every call type you can define a ring tone. Click  
to open the list of available audio files. You can listen to 
the audio files with .

Text colour Select the colour you want for each individual call type 
by clicking on the colour field.

Call Description

Call type The acoustic signal for incoming calls can be set as fol-
lows:
Ring tone off: Ring off
Single ring: Phone rings just once. Ring can be set in 
such a way that your phone only rings quietly, with 
delay and/or during a conversation.
Periodic ring: The phone rings several times. Ring can 
be set in such a way that your phone only rings with 
delay and/or during a conversation.
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Actions during starting 
and closing

Description

On start Enter macros.

On exit Enter macros.

Substitution Description

Forwarding to substitu-
tion when application is 
closed 

Tick the checkbox and select the user you want so that 
forwarding to your substitution is automatically ena-
bled when you exit the  application. For further infor-
mation, please see "Substitution", page 44.

Focus Description

Focus after answering 
operator call (call queue) 

Click the  button to select the focus you want.

Line seizure Description

Direct mode Direct line seizure (see Chapter "Working in direct 
mode", page 43).

Incoming seizure If you have activated direct mode, you can determine 
the priority with which a call is to be answered.

Direct mode answers 
only active group calls

Activate/deactivate this function.

Operator Twincomfort Description

Activated Activate/deactivate the Twin Comfort function then 
select the settings you want.

Open Call queue window.

Open context menu and select Settings.

Select the settings you want and confirm with OK.
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Working in direct mode
If direct mode is enabled, the application detects whenever the handset is 
picked up or replaced or whenever the headset is enabled or disabled and 
reacts in the same way as an ordinary phone.

If direct mode is disabled, you seize a line and end a call exclusively using 
the application. In this case, any headset that may be connected should 
always be enabled.

Direct mode is enabled:

• The active call ends when you hang up.

• Picking up the handset seizes the line directly:
– If there is no call, a line of the preconfigured call type (internal, exter-

nal or personal) is seized to set up a connection.
– If there is an individual call, the call is answered.
– If there are several calls, the call with the highest set priority is 

answered.

Direct mode is disabled:

Picking up and hanging up the handset and enabling and disabling the 
headset have no impact on the response of the application.

Note: You cannot work in direct mode if MiVoice 1560 is coupled with a Mitel SIP 
phone.

Open Call queue window.

Open context menu and select Settings.

Select the settings you want and confirm with OK.
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Substitution
You can forward calls directed at your operator application to a preconfig-
ured destination during your absence. The substitution is automatically 
activated for all the other operator consoles as well. Personal calls are not 
affected by the call forwarding.

Notes: • Calls already on the operator application when the substitution function 
is activated are not forwarded.

• The substitution cannot be activated by remote control.
• To bypass the direct line seizure, you must first seize a line using the 

application or answer a call and only then pick up the handset or enable 
the headset.

Open Call queue window.

Open context menu and select Settings.

Select the settings you want and confirm with OK.
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Phoning on the queue

Answering a call
Your operator application rings and the MiVoice 1560 button on your PC's 
taskbar starts to flash. Use a mouse click or the corresponding hotkey to 
put the MiVoice 1560 on top.

You can answer the call in the queue. Choice available:

Ending a call
You can end a call in the operator application as follows:

Press the Enter key on the PC keyboard (the phone window must be active, see 
Chapter "Call queue settings", page 41).

Or: Double-click the line you want.

Or: 1.Highlight the line you want.
2. Right-click to open the context menu.
3. Click Answer call.

Or: Use a hotkey you have specified (see Chapter "Settings: Hotkeys", 
page 18).

Press the Enter key on the PC keyboard (the phone window must be active).

Or: In the phone window click End.

Or: Use a hotkey you have specified (see Chapter "Settings: Hotkeys", 
page 18).
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Initiating calls
You want to make a call via the operator application.

You can use the operator application to initiate calls via the queue.

Park call
You are connected with your call partner via a line and decide to put your 
call partner on hold.

You can park your call partner locally. A locally parked call partner can only 
be retrieved by the phone from which the function was initially carried out.

Mitel phones (excluding Mitel SIP phones):

Open Call queue window.

Click inside an empty line, right-click to open the context menu then select Inter-
nal call or External call.
➯Phone window opens.

Enter the phone number you want.
➯The phone number is immediately dialled.

Mitel SIP phones:

Enter the call number you want in the phone window.

Click the queue inside an empty line, right-click to open the context menu then 
select Internal call or External call.
➯The phone number is dialled.

Park call party:
In the phone window click Park.
➯Your call party is now parked locally;  is displayed in the queue.

To retrieve a parked call party:
Double-click the line you want.
Or: Highlight the line you want, right-click to open the context menu and select 
Unpark call.
➯You are now back through to your call partner.
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Switching active lines
You are in a call and want to answer a call on another line or make a call.

You can click to switch lines. The active call is automatically parked locally.

Note: If your MiVoice 1560 is coupled with a Mitel SIP phone, your Mitel SIP may 
have only 1 line. This setting is made by your system administrator.

Transferring a call
You want to put your call partner through to someone else.

With the call transfer function you can connect your call partner with some-
one else. You can connect internal and external users with one another. 
You can transfer the call with or without prior notice.

Double-click each line you want.
➯The other call party is automatically parked locally;  is displayed in the 

queue.

Menu Description

Call transfer with prior 
notice

You only transfer the call after you have first talked to the 
second call party yourself.

Call transfer without 
prior notice

Without talking to the second call party, you transfer the 
call to them by hanging up the handset immediately after 
dialling the call number.

Mitel phones (excluding Mitel SIP phones):

Call transfer with prior notice:
1. You are in a call. Enter the call number of the second call party then click 

Enquiry.
2. Wait until the person has answered the call.

➯If the other user does not answer, you can cancel the enquiry call with the 
End call button and take back the first call.

3. Announce the call party and click Connect.
➯Both call parties are connected.

Call transfer without prior notice:
Drag and drop an active call or unanswered call to the presence key you want.
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Or: 1.You are in a call. Enter the call number of the second call party then click 
Enquiry.

2. Wait for the first ring tone.
3. Click Connect or End key.
➯The second call party is then called directly by your first call party.

Note: Recall: If the second party does not answer, the call comes back to your phone.

Mitel phones (excluding Mitel SIP phones):

Mitel SIP phones:

Call transfer with prior notice:
1. You are in a call. Enter the call number of the second call party then click 

Enquiry.
2. Wait until the person has answered the call.

➯If the other user does not answer, you can cancel the enquiry call with the 
End call button and take back the first call with Take back.

3. Announce the call party and click Connect.
➯Both call parties are connected.

Or: You are in a call. Click on the presence key of the second call party, wait till 
the user takes the call then click Connect.

Or: 1.Answer the call on the queue with the entry key.
2. Enter the call number of the second call party then confirm with the enter key.
3. Wait till the user takes the call. Connect call with the enter key.

Call transfer without prior notice:
Drag and drop an active call or unanswered call to the presence key you want.

Or: You are in a call. Enter the call number of the second call party then click 
Call transfer.
➯The second call party is then called directly by your first call party.

Note: Recall: If the second party does not answer, the call comes back to your phone 
(only for active call transfer).
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Making a note about the call
You wish to make a note about the active call or to prepare for a waiting 
call: You can do so by opening the caller's contact information with a 
mouse click and e. g. taking a look at the last calls made with this call 
party.

E-Mail connection
Do you want deflect a call but the destination user is unobtainable?

You can send an e-mail to a user at any time.

Text message connection
Do you want deflect a call but the destination user is unobtainable?

You can send a text message to a user at any time.

Opening a contact for an incoming call or an active call:
In the symbol bar, click Make note about active call.
➯Note window opens.
Make your notes and save using the Ok button.
➯The notes are now stored in the journal.

Open the menu bar: Telephony > Send e-mail.

Enter the recipient and your text then confirm with Send.
➯The message is sent.

Open the menu bar: Telephony > Send SMS.

Enter the recipient and your text then confirm with Send.
➯The message is sent.
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Phoning with a personal call number
You want to make calls on your operator application without seizing a 
line.

You can make a call using your MiVoice 1560 via your personal call 
number. Your application then acts as an ordinary user; in other 
words, when making a call you will be transmitting your personal 
phone number. 

Answering a call
Your application rings and the MiVoice 1560 button on your PC's taskbar 
starts to flash. Use a mouse click or the corresponding hotkey to put the 
MiVoice 1560 on top.

To answer the call, proceed as follows: Choice available:

Rejecting a call
As long as you have not picked up a call, you can reject it during the ring-
ing phase.

Press the Enter key on the PC keyboard (the phone window must be active).

Or: In the phone window click Answer.
➯Open listening is automatically activated.

Or: Use a hotkey you have specified (see Chapter "Settings: Hotkeys", 
page 18).

Note: Stop Open listening by picking up the handset on the phone.

Click Reject.
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Deflect a call during the ringing phase
You do not want to answer a call yourself but deflect it to another user.

With the function Forward you can forward calls to an internal or external 
user or to the voice mail during the ringing phase.

Ending a call
You can end the call as follows:

Dialling with the phone number
You want to call a user.

Open the phone window. You can make, answer or process calls here.

Forwarding a call:
1. To forward the call from your MiVoice 1560, proceed as follows.
2. Enter the user's phone number.
3. Click Forward.
➯The call is deflected to the user you want.

Press the Enter key on the PC keyboard (the phone window must be active).

Or: Click End.

Or: Use a hotkey you have specified (see Chapter "Settings: Hotkeys", 
page 18).

After entering a phone number directly or using the dial pad (to open via context 
menu Window > Dial pad) you have the following call-set-up possibilities:

Press the Enter key on the PC keyboard (the phone window must be active).
➯Open listening is automatically activated.
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Dialling by name
You want to make a call by entering a name.

Requirement: The name and the corresponding call number are stored in 
one of the system’s phone book or in an external phone directory con-
nected to the system.

For dialling by name, enter the corresponding letters in the phone window 
until the user you want or a list is displayed. Since the user you want must 
be searched for in all the selected phone books, the reaction time may be 
much longer.

Selecting from the call list
For information on how to call a contact from the call list, refer to Chapter 
"Call lists", page 86.

Dialling from the phone book
For information on how to find and call a contact from the phone book, 
refer to Chapter "Searching in phone book", page 96 or "Calling from the 
phone book", page 97.

Or: Click Call.
➯Open listening is automatically activated.

Or: Use a hotkey you have specified (see Chapter "Settings: Hotkeys", 
page 18).

Note: Stop Open listening by picking up the handset on the phone.

In the phone window, enter the first letter of the name searched for then select 
the user you want.

Press Enter.
Or: Click Call.
➯The selected phone number is dialled.
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Dialling from the presence indicator
You want to call someone whose phone number is stored on a presence 
key in the presence indicator.

You can call a user using either drag-and-drop or via the context menu.

Dialling from another application
You are in a different application, for instance a Word document, and wish 
to dial a phone number stored in this document.

You can make a call directly from the application.

Call waiting on an internal user
You would like to talk to an internal user whose line is currently busy.

By using the Call waiting function, this user is informed that you would like 
to talk to him. When you use the call waiting function, the user receives a 
call waiting tone (duration and frequency of the tone depend on system 
settings) and your phone number or name appear on their display. The 
user may accept or refuse your call.

Open the Presence indicator.

Select the presence key of the user you wish to call.

Double-click.
Or: Right-click to open the context menu the click Call.
Or: Drag and drop the user you wish to call in the phone window.
➯The phone number is dialled.

Highlight the phone number you want.

Open MiVoice 1560 and press the hotkey you have stored (see chapter 
"Settings: Operation", page 17).
➯The phone number is dialled.
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Requirements:

• Your system administrator must authorise you for the function call wait-
ing in the MiVoice Office 400 communication system.

• The internal user must not have blocked the function call waiting on 
their phone (see chapter "Protection", page 104 for configuration).

Note: If your MiVoice 1560 is coupled with a Mitel SIP phone, you must configure 
for this function a function key with macro.

Answering call waiting
You are talking on the phone. The call waiting tone, name/phone number 
on the display let you know that another user would like to talk to you.

You can either answer, deflect or reject the call.

Note: If your MiVoice 1560 is coupled with a Mitel SIP phone, you must configure 
for this function a function key with macro.

The person you want to talk to is busy. Click Call waiting.
➯You hear the dialling tone.

Note: If the user declines the call request or if the function call waiting cannot be exe-
cuted, the connection is separated (busy tone) or the call is redirected to a pre-
defined phone, depending on the system configuration.

Answering the call:
Click Answer.
➯The first call party is on hold. Connected to the party using the call waiting 

function.

Rejecting a call:
Click Reject.
➯You will still be connected to the first call party. Depending on the system con-

figuration, the caller either hears the busy tone or is forwarded to a preconfig-
ured destination.

Make a conference call directly:
Click Conference.
➯All call participants are connected to each other.
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Requesting a callback
You want to talk to a certain person. The person is busy or does not 
answer. You can make callback requests to both internal and external 
users. Not all providers support this function.

If the called party is busy, you can activate an automatic callback. In this 
case, your application will start ringing as soon as the party you are trying 
to reach goes on-hook. When you pick up the handset, the person you 
want to call is dialled directly. If the called party does not answer, you can 
also request a callback. The user then obtains a message indicating your 
callback request on his display.

Note: • You can activate only one callback at a time.
• An unanswered callback will be automatically cancelled by the system 

after about 30 minutes.

Note: For more information on how to broker between the call parties, see Chapter 
"Brokering between an enquiry call party and your call partner", page 57.

Ending a current call:
Click End.
➯The first call is terminated. Connected to the party using the call waiting func-

tion.

Activating callback:
You called someone and hear the busy tone or the ring-back tone. Click Call-
back.
➯The display shows Call expected from.

Clear callback:
Click Deactivate.
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To answer the callback request
Someone has asked you to call back. The display shows Callback 
requested.

Parking a call partner
You wish to keep the person you are talking to on hold without blocking a 
phone line. 

You may park the person you are talking to and then pick up the call again 
on the same phone on which you parked the person.

Enquiry call during a call
You want to call someone else briefly without losing your current call part-
ner. Then you want to resume your conversation with your original call 
partner.

With the Enquiry call function you can call someone else in the middle of a 
call and put your original call partner on hold. You can make enquiry calls 
to both internal and external users.

Answering the callback request:
Click Call.
➯The phone number is dialled.

Clear callback:
Click Reset.
➯Callback is deactivated.

Note: You cannot delete a callback request  if MiVoice 1560 is coupled with a Mitel SIP 
phone.

Park call party:
Click Park.
➯Your call partner is now parked locally.

To retrieve a parked call party:
Click on the parked user.
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Brokering between an enquiry call party and 
your call partner
You are talking with an enquiry call party and have your first call partner on 
hold. You want to be able to switch back and forth between the two.

In an enquiry call you can use the brokering function to switch back and 
forth between an enquiry call party and the party on hold. Brokering is pos-
sible with both internal and external users. You can also broker between 
conference parties as a group and an enquiry call party.

Note: See chapter "Enquiry call during a call", page 56 for enquiry calls.

Mitel phones (excluding Mitel SIP phones):

Initiating an enquiry call:
1. You are in a call. Click Enquiry call.
2. Enter the phone number of the enquiry call party.
➯Enquiry call party is called; first call partner is on hold.

Ending an enquiry call:
Click End.
➯You are now back through to your first call partner.

Notes: • If the other user does not answer, you can cancel the enquiry call with the End 
call key: You are automatically connected to your first call partner.

• You can connect your two call parties with the Connect key.

Mitel SIP phones:

Initiating an enquiry call:
1. You are in a call. Enter the phone number of the enquiry call party.
2. Click Enquiry call.
➯Enquiry call party is called; first call partner is on hold.

Ending an enquiry call:
1. Click End.
2. Click Take back to reconnect to the first call party.

Note: If the other user does not answer, you can cancel the enquiry call with the End 
call button and take back the first call with Take back.
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Making a conference call
You want to make a conference call.

A conference call allows you to connect three call parties. From a confer-
ence call/call, you can initiate an enquiry call to someone else. You can 
broker between the parties of the conference and the enquiry call party.

Depending on the system configuration, a conference call can consist of 
up to 6 conference participants. You can hold a conference call with inter-
nal and external users.

Note: See chapter "Enquiry call during a call", page 56 for enquiry calls.

Brokering (to switch back and forth between the callers):
1. You are in an active call. You have set up a connection to another call party 

with the Enquiry call function.
2. Switch phone window and click Activate.
➯Your call partner changes. The other call party is put on hold.

Terminating a call:
Mitel phones: Click End.
➯Call party disconnected. Connected with the call party on hold.
Mitel SIP phones: Click End call then take back the first call party with the Take 
back.

Set up conference: 
1. You are in an active call. You have set up a connection to another call party 

with the Enquiry call function.
2. Click Conference.
➯The conference is set up.

Or (Mitel SIP phones only): 
1. You are in an active call. Enter the call number of another call party.
2. Click Conference.
➯The conference is set up.

Leaving a conference call:
Click End.
➯The other conference parties remain in the call.
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Transferring a call
You want to put your call partner through to someone else.

With the call transfer function you can connect your call partner with some-
one else. You can connect internal and external users with one another. 
You can transfer the call with or without prior notice.

Menu Description

Call transfer with prior 
notice

You only transfer the call after you have first talked to the 
second call party yourself.

Call transfer without 
prior notice

Without talking to the second call party, you transfer the 
call to them by hanging up the handset immediately after 
dialling the call number.

Mitel phones (excluding Mitel SIP phones):

Call transfer with prior notice:
1. You are in a call. Enter the call number of the second call party then click 

Enquiry.
2. Wait until the person has answered the call.

➯If the other user does not answer, you can cancel the enquiry call with the 
End call button and take back the first call.

3. Announce the call party and click Connect.
➯Both call parties are connected.

Call transfer without prior notice:
1. You are in a call. Enter the call number of the second call party then click 

Enquiry.
2. Wait for the first ring tone.
3. Click Connect or End key.
➯The second call party is then called directly by your first call party.

Note: Recall: If the second party does not answer, the call comes back to your phone.
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Starting an announcement
You want to speak directly to an internal user or an announcement group 
via the loudspeaker - where available - without expecting an answer (simi-
lar to an intercom). The recipient is alerted to the announcement by two 
short signal tones. You are immediately unilaterally connected via the 
loudspeaker.

If the internal user has secured their phone against announcements (con-
figuration see chapter "Protection", page 104), you cannot contact them 
using an announcement. You will get the engaged tone.

Emergency announcement:

In addition to normal announcements, the MiVoice Office 400 communica-
tion system also allows for emergency announcements. It differs from a 
normal announcement in the following aspects:

• You cannot reply to or stop an emergency announcement.
• You cannot block an emergency announcement.

• An emergency announcement may only be executed using function 
codes. You will find a list of all function codes in the user guide “Fea-
tures Overview Mitel 415/430/470” on the Mitel DocFinder.

Mitel SIP phones:

Call transfer with prior notice:
1. You are in a call. Enter the call number of the second call party then click 

Enquiry.
2. Wait until the person has answered the call.

➯If the other user does not answer, you can cancel the enquiry call with the 
End call button and take back the first call with Take back.

3. Announce the call party and click Connect.
➯Both call parties are connected.

Call transfer without prior notice:
You are in a call. Enter the call number of the second call party then click Call 
transfer.
➯The second call party is then called directly by your first call party.

Note: Recall: If the second party does not answer, the call comes back to your phone.
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Announcement to a group:

• The announcement will only be received by phones which both have 
authorisation to receive announcements and are not in use.

• As soon as a user in a group picks up the handset to answer the 
announcement, the announcement is ended for all other users in the 
group.

• If receipt of announcements is not authorised on any of the phones in 
the announcement group or all the phones are in use, you will hear the 
busy tone.

• Group announcements are always conducted with a one-sided connection.

• The group number must be entered as two digits.

Note: If your MiVoice 1560 is coupled with a Mitel SIP phone, you must configure 
for this function a function key with macro.

Receiving an announcement
You will be alerted to the announcement with two short signal tones and 
spoken to directly via the loudspeaker over a one-way connection.

In order to be able to receive an announcement, your phone must be nei-
ther in use nor block announcements (configuration see chapter "Protec-
tion", page 104). To answer the announcement, the following options are 
available to you.

Announcement to a group:

• The announcement will only be received by phones which both have 
authorisation to receive announcements and are not in use.

• As soon as a user in a group picks up the handset to answer the announce-
ment, the announcement is ended for all other users in the group.

• If receipt of announcements is not authorised on any of the phones in 
the announcement group or all the phones are in use, you will hear the 
busy tone.

• Group announcements are always conducted with a one-sided connection.

Mitel phones: Enter the phone number and click Announcement.
Mitel SIP phone: Double-click the function key for Announcement.
➯User is made aware of the announcement by an acoustic signal. The connec-

tion state reads  Announcement.
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Call Forwardings
You can specify the destinations for the diversions as standard.

You can set the following diversions: 

Note: A forwarding applies to all connected phones.

Continue an announcement as a phone call:
Click Answer.

Stopping the announcement:
Click End.

Function Description

Call forwarding uncon-
ditional (CFU)

Calls for you are to be forwarded to a different destina-
tion (e.g. phone, voice mail, operator console).

Call forwarding if busy 
(CFB)

Calls for you are to be forwarded to a different destina-
tion, if you are already busy on the phone.

Call forwarding on no 
reply (CFNR)

You want calls that you receive on your phone to be for-
warded to another destination. Both your own phone and 
the other destination will then start ringing. The system 
configuration determines whether or not there is a ring-
ing delay at the other destination. Whoever goes off-
hook first, answers the call. Depending on the system 
configuration, Call Forwarding on No Reply can also be 
activated when your phone is busy (see chapter "Desti-
nations", page 103).

Open the menu bar: Telephony > Call forwardings.
➯The Call forwardings window opens.

Select the tab you want then the destination you want.

Enter the call number you want or the destination you want then confirm with 
OK.
➯Settings are saved. The corresponding symbol is displayed (symbols - see 

Chapter "Display symbols", page 27).

Note: Please note that only one forwarding can be activated at the same time.
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Operator groups

If several people deal with customer matters on the 
phone, it makes sense to create operator groups. 
Regardless of whether the incoming calls are offered 
simultaneously to your colleagues or distributed based 
on the call numbers: MiVoice 1560 provides you with a 
user-friendly group tool.

Agent control . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

Working in operator groups . . . . . . . . . . . . . . . . . . . . . . . 65

Phoning . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

Making calls in the two-company configuration . . . . . . . . 67
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Agent control

Operating elements

Display symbols
The current skill statuses to which the agent is assigned are displayed as 
follows:

No. Function

1 Log in agent Click this button to log in as agent.

2 Log off agent Click this button to log off as agent.

3 Agent in wrap up time Button displays the wrap up time defined by your 
system administrator.
Click this button to end the wrap up time prema-
turely.

4 Activate pause Click this button to activate pause.

5 Deactivate pause Click this button to deactivate pause.

Phone status display symbols

Agent status: Logged in

Agent status: Logged out

Operator groups

Substitution

Agent available

Agent ringing

Agent busy

Agent on pause

Agent in wrap up mode
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Working in operator groups
You can log in and log out as member of a operator group, and acti-
vate the pause and wrap up status, using agent control.

Your system administrator determines which users belong to which 
operator group. A user can belong to several operator groups.

Properties of an operator group
Your system administrator has the possibility of grouping several OIP PC 
operator consoles into an operator group. In doing so he will specify the 
following properties for the operator groups:

• Global operator number. Your system administrator can also specify a 
separate operator number for each operator group.

• As a member of an operator group, you have access to a number of 
agent functions of the call centre in addition to the operator functions, 
e. g. log in, log out or break.

Calls waiting

Skill active

Phone status display symbols

Operator groups Description

Group name Your system administrator enters the group name.

Status • Logged in
• Logged out

Presented calls Your system administrator specifies which operator calls 
are displayed:
• Own: only the calls you receive.
• All: all calls to this operator group.

Click on .
Or: Select Groups > Operator groups.
➯You obtain an overview of all the operator groups you are assigned to.
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Call distribution
A call is offered to a member of a operator group. If this member does not 
take the call within a defined period, the call is signalled to the next mem-
ber. If the call is not taken by the last member, the system sends the call 
back to the first member.

Your system administrator can define whether the next call should first be 
signalled again to the same member or first to the next member on the 
row, to ensure a more balanced call distribution.

Log in/log out operator groups
You are a member of one or more operator groups and wish to log in or out 
(only logged members receive calls meant for the respective operator 
groups).

You have various possibilities for logging in or out.

Log in/log out via the MiVoice 1560 symbol bar:
Click  or .

Log in/log out via a function key:
Set up a function key for yourself. For further information, please see "Add-
ing/editing/deleting function keys", page 78.

Log in/log out via agent control:

Open Agent control.
➯All operator groups which you are logged onto are listed.

Logging in to an operator group:
Click on .
➯You are logged on to all the operator groups in which you are registered as a 

member.

Log out from a operator group:
Click on .
➯You are logged out to all the operator groups in which you are registered as a 

member.
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Phoning
All telephony functions are described in Chapter "Phoning on the queue", 
page 45.

Making calls in the two-company configu-
ration
This section explains the options provided by your MiVoice 1560 if 
the two-company configuration is activated in the system. Contact 
your system administrator for more information.

In a two-company configuration your operator application signals 
whether an incoming call is for company A or company B.

Properties of a two-company configuration
The following properties apply to a two-company configuration:

• Call lists are not kept separately according to company.

• The call charges are recorded separately for each company.
• A substitution will apply equally to both companies.

Note: In a two-company configuration you must not be configured as an agent as 
the agent enjoys a higher priority.

Answering a call on a two-company 
configuration
You handle the calls for two different companies on the same operator 
application, and the operator application is configured as a two-company 
system.
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Making a call on a two-company configuration
You are operating a two-company configuration and want to appear either 
as Company A or as Company B, as necessary.

1. You receive a call. The queue indicates the company for which the incoming 
call is intended.

2. Activate MiVoice 1560 and answer the call:
– with a double-click,
– with your hotkey, or
– via the context menu.

Mitel phones (excluding Mitel SIP phones):

Click the  or  button on the toolbar.
Or: Select Telephony > Outgoing calls for company: Company A or Company B.
➯You are now making and receiving calls in your capacity as company A or B.

Open the Call queue.

Right-click to open the context menu and select Internal call or External call.
➯Phone window opens.

Enter the call number you want.
➯The phone number is immediately dialled.

Mitel SIP phones:

Click the  or  button on the toolbar.
Or: Select Telephony > Outgoing calls for company: Company A or Company B.
➯You are now making and receiving calls in your capacity as company A or B.

Enter the call number you want in the phone window.

Click a blank line on the queue, right-click to open the context menu and select 
Internal call or External call.
➯The phone number is dialled.
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Presence indicator and Cal-
endar

Configure the presence keys in the presence indicator. 
You can use these keys to view the telephony status 
(free, in a call) of a user and also his/her presence sta-
tus (available, busy, meeting). You can also send text 
messages or make a call directly from the presence 
indicator.

Configure your function keys also in the presence indi-
cator.

Once you have carried out the synchronisation settings 
you want, the application and Microsoft Outlook calen-
dars will be synchronised according to your settings. 
Define in that chapter where to complete your calendar 
entries.

Presence indicator settings . . . . . . . . . . . . . . . . . . . . . . . 70

Personal presence state . . . . . . . . . . . . . . . . . . . . . . . . . 74

Groups and items (Presence indicator) . . . . . . . . . . . . . . 75

Actions in the presence indicator. . . . . . . . . . . . . . . . . . . 79

Personal calendar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81

Actions in the calendar  . . . . . . . . . . . . . . . . . . . . . . . . . . 82
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Presence indicator settings
These sections explain how you can integrate the presence indicator 
to your everyday business life for a quick overview.

Settings
These default settings are valid for the whole of the presence indicator. 
Select from the following settings:

Setting Description

Show team keys The team keys configured on the phone are displayed. If 
this option is enabled, manual settings are erased when 
next the presence indicator is started.

Show ACD skills If the application belongs to an operator console group, 
the group members are displayed in a tab.

Flash on ringing call Calls are indicated with a flashing presence indicator.

Ring tone off Calls are not signalled acoustically.

Note: You can also disable the ringing tone for an incoming 
call, by opening the context menu of the corresponding 
user and clicking Ring tone off.

• User item colour
• Function key colour
• Line key colour

Select the colour you want for each item by clicking on 
the colour field. These colour settings can be changed at 
any time for each individual item.

Open the Presence indicator.

Open the context menu and select Settings.

Select the settings you want and click OK to confirm.
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Item field
The presence indicator shows at one glance which function keys you have 
configured and which of your team partners or groups are currently availa-
ble. The presence status of the users is indicated on the one hand by dif-
ferent colours for the user fields and on the other by the symbols of status.

For even greater clarity you can drag and drop individual items directly 
onto your desktop.

The number of item fields is limited by the size of the presence indicator 
window. For further information on groups and items please refer to Chap-
ter "Groups and items (Presence indicator)", page 75.

No. User

1 User name  

2 User call number

3 Presence state/Absence 
reason

4 User call number defini-
tion

Indicates the call number (private, business 
number) on which a user can be reached.

5 User status

Item order The item order is fixed or can be moved within the 
window.

Function key

The function key summary gives you an overview of the functions keys you 
have configured. The function key status is presented in various colours.
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Display symbols

Phone status/presence state

Making a call

Alerting

Connected

Conference

Available

Busy

Meeting

Absent

Not available

Unknown

User call number

Private

Office

Cordless phones

Voice mail

Conference

Do not disturb

Follow me

Forwarded
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Agent status

Pause

Wrap-up time

User status

Connected

Available

Absent

Busy, announcement

Meeting, conference

Not available

Function key

Function

Function deactivated

Function activated
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Personal presence state
The presence state shows your current status. The subscriber status 
is set automatically depending on the destination or you change it 
manually.

If you activate the reminder function, a reminder message is dis-
played on your phone if set accordingly. Calendar entries in Micro-
soft Outlook are also displayed on your phone as a reminder. This is 
particularly very useful with cordless phones, since appointments 
are also displayed while you are away.

The reminder message is displayed on the cordless phone if twin 
comfort mode is activated.

Setting the presence state
You wish to specify your presence state manually.

For further information regarding presence state refer to Chapter "Pres-
ence state", page 106.

Select Telephony > Set presence state.

From the selection, select Presence state and Absence reason, enter Subject, 
City and end time, then confirm with OK.
➯The corresponding symbol is indicated in the phone window display (see 

Chapter "Presence indicator settings", page 70). To obtain more details click 
the symbol once.

Notes: • If you enter the end time, this time is automatically entered in the OIP/ 
Exchange calendar.

• You can also modify your own presence status by opening your user field con-
text menu in the presence indicator and choosing Presence.
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Groups and items (Presence indicator)
These sections explain how to manage groups and items.

Adding or deleting a group
You want to add or delete a (new) group.

Group settings
These settings apply for each selected group. Select from the following 
settings:

Open the Presence indicator.

Add group:
1. Open the context menu and select Add group.
2. Enter a new group name and confirm with OK.

Rename group:
1. Select the group you want.
2. Open the context menu and select  Group settings.
3. Enter a new group name and confirm with OK.

Delete group:
1. Select the group you want.
2. Open the context menu and select Delete group.
3. Answer Yes to the security question.

Note: These functions are also accessible via the context menu of the right mouse 
key.

Setting Description

Group name Give the group a name.

Group colour Select the colour you want to give the group.

Item order • Automatic: The individual items are ordered automat-
ically and cannot be re-ordered.

• Free: You can order the individual items to suit your 
requirements.
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Item size Select the item size you want.

Item title font size Select the font size you want.

Grid size • Fit to window: The grid automatically adapts to the 
size of the window.

• User defined: Enter the number of columns and rows 
you want.

Show grid Tick the checkbox if you want the grid to be opened. 

Setting Description

Defining group settings:
Open the Presence indicator.

Select the group you want.

Open the context menu and select  Group settings.

Select the settings you want and click OK to confirm.

Copying item colour:
Open the item's context menu (presence, function, line), its item colour you wish 
to copy, with the right mouse button.

Click Copy colour.

Right-click to open the context menu of the item you want to add colour to.

Click Add colour.

Note: Use the Reset colour Foxkey to reset the colour selection back to the default 
value.
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Adding/editing/deleting users
You want to add new users to a group.

You can set the properties individually for each user.

Note: Users can be attached to several groups at the same time.

Setting Description

User Select the user you want.

Name Give your item a name.

Ring tone For each item you can define a ring tone. Click  to 
open the list of available audio files. You can listen to the 
audio files with .

Delay Ringing tone is only activated after a set time and stops 
again after a set time.

Opacity Full opacity or opacity with which other application win-
dows are to be covered. The setting is activated only if 
the item is dragged to the Desktop.

User item colour Select the colour you want for the item by clicking on the 
colour field. Use the Reset button to delete the choice of 
colour.

Open the Presence indicator.

Adding items:
1. Select the group you want.
2. Open the context menu and select Add item.
3. Choose Presence then the user you want.
4. Select the settings you want and click OK to confirm.

Editing properties:
1. Right-click to open the context menu of the user whose settings you want to 

change.
2. Click Properties.
3. Select the settings you want and click OK to confirm.
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Adding/editing/deleting function keys
You want to add new function keys to a group.

You can set the properties individually for each function key.

Note: The available functions can be found in the chapter "Function profiles", 
page 118.

Deleting items:
1. Right-click to open the context menu of the user you want to delete.
2. Select Delete item.
3. Answer Yes to the security question.

Note: These functions are also accessible via the context menu of the right mouse 
key.

Setting Description

Name Give your item a name.

Hotkeys Select the hotkey for the individual items by pressing 
one or two hotkeys (Alt key, Control key and/or Shift 
key together with your choice of letter, digit or function 
key).

Opacity Full opacity or opacity with which other application win-
dows are to be covered. The setting is activated only if 
the item is dragged to the Desktop.

Function key colour Select the colour you want for the item by clicking on the 
colour field. Use the Reset button to delete the choice of 
colour.

Open the Presence indicator.

Adding items:
1. Select the group you want.
2. Open the context menu and select Add item.
3. Select Function key.
4. Click Modify to select the function and settings you want, then click OK to con-

firm.
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Actions in the presence indicator
The following sections explain how you can make calls directly in the 
presence indicator.

Initiating actions
Right-click to open the context menu of the user concerned to trigger any 
of the following actions:

Editing properties:
1. Right-click to open the context menu of the function key whose features you 

want to change.
2. Click Properties.
3. Select the settings you want and click OK to confirm.

Deleting items:
1. Right-click to open the context menu of the function key you want to delete.
2. Select Delete item.
3. Answer Yes to the security question.

Note: These functions are also accessible via the context menu of the right mouse key.

Action Description

Call Call any user you want.

Call forwardings You can modify a user's call forwarding.

Presence You can modify a user's presence status.

Announcement to Speak directly to an internal user via the loudspeaker - 
where available - without them having to first pick up the 
call. An announcement is then made without call signal on 
and without call confirmation from the destination phone.

E-mail Send an e-mail to a user.

Contact details Call up a user's contact details.

Callback from Activate the callback of an internal or external user who 
is busy or not answering.
If the called party is busy, you can activate an automatic 
callback. In this case, your phone will start ringing as 
soon as the party you are trying to reach goes on-hook. 
When you pick up the handset, the person you want to 
call is dialled directly.
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Messages Send a message to a user.

Ring tone off Calls are not signalled acoustically.

Pick up from You can take another user’s call, depending on the 
authorisation profile assigned to you by the system 
administrator.

Action Description

Call:
1. Right-click to open the context menu of the user you want to call.
2. Click Call or double-click.
3. If necessary, choose the call number you want.

Calling with drag-and-drop:
Drag the user you wish to call using drag and drop in the phone window.
➯The user is dialled.

Announcement:
1. Right-click to open the context menu of the user for whom you want to start an 

announcement.
2. Click Announcement to.

Callback:
1. Right-click to open the context menu of the user from whom you want a call-

back.
2. Click Callback from.

Send message:
1. Right-click to open the context menu of the user to whom you want to send a 

text message.
2. Click Messages.
3. Select the message type you want.
4. Write your text message and confirm with Send.

Answering calls for another user:
1. Right-click to open the context menu of the user whose calls you want to 

answer.
2. Click Pick up from.
➯You are connected.
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Personal calendar
This section explains how to adapt the calendar to suit your personal 
requirements.

Settings
Select from the following settings:

If you want calendar events to be displayed on your phone's display too, 
select Telephony > Notifications and tick the Calender events checkbox.

Setting Description

Show reminders The application sends you reminders of your calendar 
events.

Reminder tone Choose the ringing tone with which your application 
should remind about your calendar entries. Click  to 
open the list of available audio files. You can listen to the 
audio files with .

Open the calendar.

Open the context menu and select Settings.

Select the settings you want and click OK to confirm.
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Actions in the calendar
This section explains how to adapt the calendar to suit your personal 
requirements.

Displaying/adding/editing/deleting a calendar 
entry
You wish to make, edit or delete a new entry in your calendar.

Open the calendar.

Displaying a calendar entry:
Choose the entry you wish to display and double-click to open it.

Adding a calendar entry:
Double-click the day you want in the calendar.
Or:
Right-click to open the context menu and select  New.
Select the settings you want and click OK to confirm.

Editing a calendar entry:
Double-click the entry you want.
Or:
Select the entry you want, right-click to open the context menu and select Edit.
Select the settings you want and click OK to confirm.

Deleting a calendar entry:
1. Select the entry you want.
2. Right-click to open the context menu.
3. Select Delete.
4. Answer Yes to the security question.
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Journal

The following sections explain how to maintain an over-
view and keep control of your calls, voice messages 
and text messages.

Settings of the Journal. . . . . . . . . . . . . . . . . . . . . . . . . . . 84

Call lists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86

Text messages and voice messages. . . . . . . . . . . . . . . . 88

Additional functions in the journal . . . . . . . . . . . . . . . . . . 89
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Settings of the Journal
This section explains how to adapt the journal to suit your personal 
requirements.

Settings

Setting Description

Visible tabs:
• Missed
• Answered
• Redial list
• Text messages
• Voice messages

Activate the call lists you want to display.

Journal mode:
• Permanently
• Dynamic

• Disabled

• all calls are entered in the journal.
• Calls are entered in the journal only if the application is 

open.
• Calls are never entered in the journal.

Set entry as viewed Activate whether an entry is marked as read after a cer-
tain period, or when scrolling to the next entry.

Open the journal.

Open the context menu and select Settings.

Select the settings you want and click OK to confirm.
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Display symbols

Journal display symbols

Missed (unanswered) calls

Answered calls

Redial

Text messages

Voice messages

Call user

Save user

Delete entry

Write note

Delete note

Set to-do reminder

Delete follow up

Locking a user

Unlock user
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86 MiVoice 1560 PC Operator

Set filter

Call lists
This section explains how to make calls via the journal.

Call list of unanswered calls
You want to call someone who has previously tried to reach you.

Your application automatically saves this user's call number in a call list 
and  is displayed. You can now call the person back using the journal.

The system erases all entries in the journal after a specific time (default 
setting 10 days). Contact your system administrator for more information. 
You can lock individual users if you do not want them to be erased from 
any of the lists.

Setting Description

Internal calls Only internal calls are displayed.

External calls Only external calls are displayed.

Open the journal.

Open the context menu and select Filter.

Select the filter you want and click OK to confirm.

Click on  in the phone window.

Call user:
Double-click the user you want.
Or: Highlight the user and click .
➯The selected phone number is dialled.

Note: All other available additional functions are described in Chapter "Additional 
functions in the journal", page 89.
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Call list of answered calls
You want to call back someone whose call you answered.

Your application automatically stores this users’s phone number. You can 
now call the person back using the journal.

Redial
You want to call a person you have already called.

In the redial list your application automatically stores the phone numbers 
of the persons you have already called, complete with their names, where 
available. You can call back the person in question using this list.

Select the Answered tab from the journal.

Call user:
Double-click the user you want.
Or: Highlight the user and click .

Note: All other available additional functions are described in Chapter "Additional 
functions in the journal", page 89.

Click on in the display.
Or: Select the Redial tab from the journal.

Call user:
Double-click the user you want.
Or: Highlight the user and click .

Note: All other available additional functions are described in Chapter "Additional 
functions in the journal", page 89.
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Text messages and voice messages
This section explains how to retrieve messages via the journal.

Text messages
You want to read a text message you have received.

Voice messages
You want to listen to a voice message you have received.

Click on  in the phone window.
➯The Text messages tab window in the journal opens.

Read text messages:
Highlight the user you want then click .
Or: Double-click the user you want.

Deleting a text message from the list:
Highlight the user you want then click .

Note: To find out how to compose a text message, refer to the Chapter "Functions in 
phone book", page 96.

Click on  in the phone window.
➯The Voice messages tab window in the journal opens.

Play voice message:
Highlight the user, click  and select the media to play the voice message.

Deleting a voice message from the list:
Highlight the user and click .

Note: To find out how to set a voice mail greeting, refer to chapter "Managing personal 
voice mail greetings", page 112.
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Additional functions in the journal
Regardless of which list you are in, you have various action options 
for editing an entry.

Actions
Highlight the user you want and select one of the following possibilities for 
editing:

• using the button,

• by double-clicking the corresponding column,
• by right-clicking to obtain the context menu.

Action Description

Call Call any user you want.

Announcement to Speak directly to an internal user via the loudspeaker - 
where available - without them having to first pick up the 
call. An announcement is then made without call signal 
on and without call confirmation from the destination 
phone.

Callback from Activate the callback of an internal or external user who 
is busy or not answering. Not all network operators sup-
port his function.
If the called party is busy, you can activate an automatic 
callback. In this case, your phone will start ringing as 
soon as the party you are trying to reach goes on-hook. 
When you pick up the handset, the person you want to 
call is dialled directly.

Messages Send a message to a user.

Ring tone off Calls are not signalled acoustically.

Pick up from You can take another user’s call, depending on the 
authorisation profile assigned to you by the system 
administrator.

Storing a user in the phone book:
Highlight the user and click .

Complete the contact data and click .
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Note: For further information about phone book refer to Chapter "Phone Book Man-
agement", page 93.

Deleting a user from the list:
Highlight the user and click .

Making a note about the call:
Highlight the user and click .

Note: During a call you can also leave a note for this user and confirm with OK.

Deleting a note:
Highlight the user and click .

Add follow up to user:
Highlight the user and click .
➯This follow up serves as a reminder (example: call back user).

Delete follow up:
Highlight the user and click .

Locking a user:
Highlight the user and click .
➯The user is locked. This means that the user cannot be deleted from the sys-

tem.

Deleting locking:
Highlight the user and click  again.
➯Lock is deleted.
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Phone book

The following sections explain which phone books are 
available to you and how you can use them.

Settings of the phone book . . . . . . . . . . . . . . . . . . . . . . . 92

Phone Book Management . . . . . . . . . . . . . . . . . . . . . . . . 93

Functions in phone book . . . . . . . . . . . . . . . . . . . . . . . . . 96
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Settings of the phone book
This section explains how to adapt the phone book to suit your per-
sonal requirements.

The response time may vary greatly depending on the size and the 
number of phone books connected and selected.

Settings

Display symbols

Setting Description

Show also contacts 
without name entry

Tick the checkbox if you also want to display contacts 
those name field has been left blank.

Open the Phone book.

Open the context menu and select Settings.

Select the settings you want and click OK to confirm.
➯Settings are saved.

Phone book display symbols

Save new contact

Edit contact

Delete contact

Call contact

Send contact a message

Search

List

Cards
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Phone Book Management
This section explains which phone books are available to you, how to 
create a new entry in the phone book and how to edit or delete an 
entry.

Available phone books
Communication inside the company becomes much more effective if 
telephony is integrated into the IT systems. The already existing directo-
ries, databanks and phone books can be used to make calls by name or to 
identify incoming calls (displaying names instead of just numbers) on all 
Mitel phones.

There are communication server directories, OIP directories and external 
directories. All your communication system users are stored in the commu-
nication server directory. OIP (Mitel Open Interfaces Platform) is a soft-
ware component that combines language with IT, thus telephony with com-
puter applications and e. g.  integrates phone books, Exchange contacts 
and Outlook calendar. OIP and communication server are synchronised on 
a regular basis. It is therefore sensible to display either the OIP or the com-
munication server directories. The OIP directories have a larger capacity; 
a contact can have several phone numbers; the OIP private phone book 
enables subfolders.

Depending on the system configuration and the phone books integrated by 
your system administrator, you can display various internal and external 
phone books.

Directories Description

Communication server directories • Public phone book
• User directory
• Network users

OIP directories • Public phone book (OIP)
• User directory (OIP)

Microsoft directories • Microsoft Active Directory

Default data bases • LDAP directory
• JDBC/ODBC directory
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Editing Phone Books
You can only create new private phone books, and rename or delete them.

External electronic telephone directories 
(example)

• TwixTel
• DasTelefonbuch

Private phone books • Private contacts
• Private contacts (OIP) incl. private 

Outlook contacts

Directories Description

Open the Phone book.

Displaying phone books:
1. Highlight All phone books.
2. Right-click to open the context menu.
3. Select Other phone books.
4. Select individually the phone books that are to be displayed.

Note: You can change the presentation of phone book entries with the  View between 
List and Contact cards.

Hiding a phone book:
1. Highlight the phone book you want.
2. Right-click to open the context menu.
3. Select Hide phone book.

Open the Phone book.

Creating a new phone book:
1. Highlight the private phone book you want.
2. Right-click to open the context menu.
3. Select New phone book.
4. Enter a name.
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Creating a New Phone Book Entry
You want to create a new private contact.

You can store private contacts in a private phone book only.

A contact can have several entries (phone number, address, e-mail). You 
can define one of these entries as default. Activate the checkbox  behind 
the entry.

Editing or deleting a phone book entry
You want to modify a contact stored in a private phone book.

You can only edit entries in a private phone book.

Rename phone book:
1. Highlight the private phone book you want.
2. Right-click to open the context menu.
3. Select Rename phone book.
4. Enter a new name.

Delete phone books:
1. Highlight the private phone book you want.
2. Right-click to open the context menu.
3. Select Delete phone book.
4. Answer Yes to the security question.

Highlight the private phone book you want and click New. 

In the General or Details  tab enter all the contact data you want and confirm 
with .

Modifying a contact:
Highlight the contact you want in the private phone book and click .
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Functions in phone book
This section explains useful phone book functions.

Searching in phone book
You want to search a contact directly in one of the connected and selected 
phone books.

With directory lookup, you can search for an contact in your private phone 
book, system phone book or a connected external phone book. The 
response time may vary depending on the size and the number of phone 
books connected. The following search options are available:

Modify the contact data and confirm with .

Delete contact:
Highlight the contact you want in the private phone book and click . Answer 
Yes to the security question. 

Search Description

Highlight the user Highlight the contact directly in the phone book you 
want.

 / Click the right edge of the phone book window on  or 
 or the corresponding letters then select the contact 

you want.

Quick search In the highlighted phone book enter the first letters of the 
name to find until the user you are looking for appears.

Search (Advanced 
search)

In advanced search mode you can limit your search with 
specific search criteria in order to obtain target search 
results. The search criteria are:

• Search In Contacts or Journal entries (if you opened the 
Advanced Search via the phone window).

• Search text Enter a meaningful search text such as name or phone 
number. All fields will be searched if you do not specify 
any field constraints. If the fields are not displayed, click 

. The search text in the advanced search can contain 
any part of the stored contact.
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Calling from the phone book
You can make a call directly from the phone book or from an open contact.

Full text search Activate the full text search if you do not want to restrict 
yourself to individual or complete search criteria. The 
character string you are looking for does not have to be 
the start of the name you are looking for.

Phone book selection Select specific phone books by clicking .

Presentation of phone 
book entries

You can change the presentation of the phone book 
entries with the View button between List and Cards.

Search Description

Open the Phone book.

Highlight the phone book you want or All phone books.

Quick search:
In the Quick search window enter the first letters of the name to find until the 
user you are looking for appears.

Note: For Quick find to be displayed, the size of the phone book window must be 
adjusted accordingly.

Click Call and select the phone number you want.

Search (Advanced search):
Click Search.
Enter your search criteria and click Find now.

Highlight the user you want then click Select to select the phone number you 
want.

Full text search:
Open the context menu in the Search window and select Full text search.
Enter the character string and click Search now.

Note: • The search function is not affected by upper/lower case and special charac-
ters.

• To find out how to create a new contact in your private phone book, refer to the 
Chapter "Creating a New Phone Book Entry", page 95.

• You can also access the advanced search function through the context menu 
of each window.
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Open the Phone book.

Highlight the contact in the phone book you want.

Click on  and select the phone number you want.
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Sending message from the phone book
You want to send a written message to a user. Requirement: The user 
must have a phone capable of receiving messages. You can send the fol-
lowing messages to a user:

Function Description

Text message via com-
munication server

The message is sent via communication server (to com-
munication server users).

Text message via OIP The message is sent via OIP (to OIP users).

E-mail The message is sent as an e-mail (provided there is an 
existing connection to an e-mail server or the local Out-
look; contact your system administrator for more infor-
mation).

Display text The message is written as text on the phone display and 
on the external display.

Open the Phone book.

Highlight the contact in the phone book you want.

Click Messages.
Select the message type you want then write the text you want.
Confirm with Send.

Note: You can send messages via this Menu : Telephony > Send e-mail / Send SMS. 
Or from the presence indicator, see Chapter "Actions in the presence indicator", 
page 79.
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Configuration

The following sections explain how to adapt the default 
settings of  the application to your personal require-
ments so that it combines ideally with other activities 
on your PC.

User. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

Profiles  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106
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User
Carry out the following partial steps to make your personal settings.

Private settings
You can enter your personal data such as Password for the application (by 
default 0000), your user PIN as well as your personal phone number and 
e-mail addresses.

Note: Your PIN applies to all your phones.

Activate presence state synchronisation:

You have three possibilities for specifying how your presence state is syn-
chronized between the communication server and Outlook. Both settings 
are activated as standard.

What's more, if you change the presence state on your phone to Available 
(Deactivate), you cancel all the active appointments in Outlook and not just 
the appointments that currently control your presence state. The excep-
tions are the following entries in Outlook, which are not cancelled when the 
presence state is deactivated:

• Appointments lasting several days,

Setting Description

Outlook to communication 
server

 If you change your presence state manually in the 
application, the changes and the appointments in 
Outlook are synchronized in the communication 
server and displayed on your phone. Although 
changes to your presence state on your phone are 
adopted in OIP, they do not change your Outlook 
appointments.

• Outlook to communica-
tion server

• Communication server 
to Outlook

 If you change your presence state manually in the 
application, the changes and your appointments in 
Outlook are synchronized in the communication 
server and displayed on your phone. Changes to your 
presence state on your phone are adopted in OIP and 
also synchronised in Outlook.

Both settings are deacti-
vated

You can only change your presence state in the com-
munication server manually in the application. The 
communication server to Outlook setting is also auto-
matically deactivated if the Outlook to communication 
server setting is deactivated.
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• Appointments lasting an entire day,
• Appointments already set to the Available  presence state.

Note: You can also change your presence state in the MiVoice 1560 (see the 
Chapter "Setting the presence state", page 74).

Destinations
Depending on the authorisation profile given to you by your system admin-
istrator, you have the right to set the following destinations and options for 
your phone in MiVoice 1560.

Open the Configuration.

Select the User  dialog box.

Select the Private settings tab.

Enter a password/PIN:
1. Click on .
2. Enter the values you want.
3. Confirm with OK.

Synchronise presence state:
Tick the checkbox with the setting you want.

Setting Description

Predefined destina-
tions

Calls are forwarded to a preconfigured destination.

Unreachable destina-
tions

Call  forwarding in case of unreachability to a preconfig-
ured destination.

Forwarding options If you enable Call forwarding on busy, any incoming call 
is deflected directly. If you enable CFU on first call, you 
will be alerted to an incoming call although call forward-
ing has been enabled; in this case, you have 5 seconds 
to answer the call.

Standard call forward-
ing

Define standard call forwarding for internal and external 
calls on no answer, on busy or when the phone is not 
available.
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Protection
You want to protect yourself against certain types of calls. You can protect 
yourself against the following call types:

Open the Configuration.

Select the User  dialog box.

Select the Destinations tab.

Select the settings you want and click Apply to confirm.

Setting Description

Call waiting protection If you enable this protection, you will not receive any 
optical (display) or acoustic (call waiting tone) signal that 
another user wishes to talk to you while you are already 
busy with a call.

Call intrusion protec-
tion

If you activate this protection, it is not possible for a third 
user to intrude on your active call and listen in to your 
conversation.

Call forwarding protec-
tion

If you enable this protection, incoming calls cannot be 
forwarded directly to your phone.

Announcement protec-
tion

If you enable this protection, internal users cannot speak 
to you directly via your loudspeaker, that is without first 
waiting for an answer from you.

Do not disturb If you enable this protection, calls coming into your 
phone are automatically forwarded to a specific destina-
tion.

Remote control protec-
tion

If you enable this protection, no configuration adjust-
ments can be made through remote maintenance but 
only locally on your phone.

Silent intrusion protec-
tion

If you enable this protection, it is not possible for a third 
user to intrude on your active call without optical or 
acoustic signals (i.e. without this being noticed by you 
and your correspondent) and listen in to your conversa-
tion.
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Line access
You want to transfer line access to a user.

You can assign a user a right (Control or Monitor) for the own line.

Open the Configuration.

Select the User  dialog box.

Select the Protections tab.

Select the settings you want and click Apply to confirm.

Open the Configuration.

Select the User  dialog box.

Select the Line access tab.

Add line:
1. Use Add to choose the line you want.
2. Transfer the right.

Deleting line:
1. Highlight the line you want.
2. Click Delete.
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Profiles
The presence profile enables you to manage your individual incom-
ing calls according to your presence status. If you are leaving your 
desk, you can activate the corresponding presence profile. During 
your absence, this profile manages call switching, call notification 
and voice mail activities. When you return to your desk, activate the 
corresponding presence profile.

It is also possible to have presence profiles activated and deacti-
vated automatically according to the current presence status.

Presence state
Presence states are set states that provide information about the current 
presence and availability of you or another OIP user. The presence state 
can be specified for each OIP user and, thus, for each communication 
server user. It is indicated through the Presence indicator (see chapter 
"Presence indicator and Calendar", page 69). It gives several instances 
that can set the presence state. The presence indicator always shows the 
last presence state set.

Example: 
If in the OIP calendar your presence status is set to Busy, the presence 
indicator displays Busy. Change now your presence status manually via 
your MiVoice 1560 (see chapter "Setting the presence state", page 74) to 
Available. The presence indicator changes to Available. The presence sta-
tus of the OIP calendar remains on Busy.

If OIP is associated with a Microsoft Exchange Server, the OIP calendar 
accepts the presence status of Microsoft Outlook. The assignment of the 
Exchange status versus the OIP status is as follows:

Presence state MiVoice 1560 Presence state
MicrosoftOutlook Calendar

Available Free

Absent Absent

Meeting Absent

Busy Booked / busy

Not available Tentative

Unknown Absent
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Create new profile, copy profile, delete profile
Depending on the authorisation profile assigned to you by your system 
administrator, you have the right to create, copy or delete new profiles in 
MiVoice 1560. Contact your system administrator for more information.

You may either create a new profile or take any of the available default pro-
files and adapt it to your own needs. You can create as many presence 
profiles as you want.

You may only define the profiles you have defined yourself. You cannot 
delete default profiles.

Note: Find further information for profile settings in the following chapters.

Open the Configuration.

Select the Profile dialog box.

Creating a new profile:
1. Click the  button.
2. Enter a name.
3. Select the template you want and click OK to confirm.
➯You can now enter your settings for this profile.

Copy profile:
1. Highlight the profile you want.
2. Click the  button.
3. Enter a name.
4. Select the template you want and click OK to confirm.
➯You can now enter your settings for this profile.

Note: You can copy any profile type (Private, Public, Templay).

Delete profile:
1. Highlight the profile you want.
2. Click the  button.
3. Answer Yes to the security question.
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Activate profile
You can activate individual presence profiles. If you select another pres-
ence profile, the current profile is automatically deactivated.

The presence profile is activated independently of the presence status 
(see Chapter "Presence state", page 106). Otherwise, you can activate a 
presence profile manually ("Setting the presence state", page 74) via your 
phone.

When a presence profile is activated all the settings for this profile are acti-
vated.

Profile switch
You can use the profile switch to activate and deactivate presence profiles 
according to the MiVoice 1560 presence status. If you have linked 
MiVoice 1560 to Microsoft Outlook, the presence profiles will be switched 
according to Outlook’s presence status.

Open the profile switch window and make the following settings:

Once the presence status changes or an event occurs, and if you have set 
the profile for it, the current presence status activates the associated pres-
ence profile.

Activate profile:
Open the Configuration.

Select the Profile dialog box.

Highlight the presence profile you want and click .
➯  is displayed when the presence profile is activated.

Notes: • function can also be used via the context menu of the right mouse key.
• function can also be used via the context menu of the phone window.

Setting Description

Switch profile on presence 
state change

Select the profiles for the individual presence 
state.

Switch profile on application 
event

Select the profile for each event.
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General settings
Your system administrator has configured your application with default pro-
files. You can use these default profiles or adapt them to your needs, 
depending on the user rights given to you by the system administrator.

Profile switch:
Open the Configuration.

Select the Profile dialog box.

Click the  button.

Select the profile you want for each presence status and event.

Confirm with OK.

Setting Description

Name Profile name.

Profile availability • Private: available to its owner only.
• Public: available to all OIP users; can be acti-

vated/deactivated individually.
• Template: used as a template for creating public and 

private profiles. The template cannot be used directly 
as a profile and therefore cannot be activated.

• System generated by an OIP service; as a rule can-
not be modified.

Deactivation locked for 
profile switch

The profile can only be deactivated manually and not 
through the profile switch. For further information 
refer to Chapter "Profile switch", page 108.

Presence state Status inserted in the user field in the presence indi-
cator. For more information see Chapter "Presence 
state", page 106.

Absence reason Reason inserted in the user field in the presence indi-
cator.

Subject Text inserted in the user field in the presence indica-
tor.

City City inserted in the user field in the presence indica-
tor.
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Call forwarding profiles
You can specify the destinations for the diversions as standard.

Notes: • You can only activate 1 call forwarding at a time.

• Personal call routing can simultaneously be activated with Call forward-
ing on busy or Call forwarding on No Reply.

General settings:
Open the Configuration.

Select the Profile dialog box.

Highlight the profile you want and select the General tab.

Select the settings you want and click Apply to confirm.

Setting Description

Profile controls call for-
warding

This forwarding is also activated/deactivated when the 
presence profile is activated/deactivated. If unchecked, 
the settings are ignored and call forwarding is not acti-
vated/deactivated.

Destination Destination of call forwarding.

Force settings of the 
profile

Prevents other instances from modifying the forwarding 
settings defined here, as long as this presence profile is 
active. Other instances can be: User interaction through 
the system phone or softphone, forwarding destinations 
of the presence indicator, MiVoice 1560 or a softphone, 
default forwarding destinations defined in the communi-
cation server.

Configuring call routing:
In the configuration window select the Profiles dialogue field.

Highlight the profile you want and select the Call forwarding tab.

Select the call forwarding you want and click Change.
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Voice mail profiles
You want to forward a call to a voice mail.

You can specify the voice mail to which the call is to be forwarded. Assign 
a voice mail profile to your presence profile.

Select the destination you want and the relevant settings and click OK, then 
Apply to confirm.

Note: You can also open the Call forwarding window using the corresponding symbol 
in the phone window (see chapter "Display symbols", page 27), or via Teleph-
ony  Call forwarding.

Configuring call routings:
In the configuration window select the Profiles dialogue field.

1. Highlight the profile you want.
2. Select the Call forwardings tab.
3. Tick Use personal call routing.
4. Select the call routing you want.
5. Confirm with Apply.

Highlight the profile you want and select the Call forwarding tab.

Tick Use personal call routing then select the call routing you want.

Confirm with Apply.

Configuring voice mail profiles:
Open the Configuration.

Select the Profile dialog box.

Select the Voice mail tab.

Use Configuration to choose the voice mail greeting you want.

Confirm with Apply.

Note: To manage a voice mail greeting, refer to chapter "Managing personal voice 
mail greetings", page 112.
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Managing personal voice mail greetings
Depending on the system configuration, you have the option of recording 
up to 3 different greetings (e.g. for absences or holidays). Give each greet-
ing a corresponding name.

If no personal greeting is activated or if none is available, the global greet-
ing is activated automatically, provided it has been recorded. You can 
obtain more information about voice mail from your system manager or in 
the Voice Mail Systems User Guide on Mitel DocFinder.

The following options are available for further editing of your voice mail 
greetings:

Menu Description

New Reset voice mail greeting.

Delete Delete voice mail greeting.

Play Play voice mail greeting

Record Record voice mail greeting.

Rename Renaming the voice mail greeting.

Activate Activating the voice mail greeting.

Select Telephony > Voice mail greetings.

Recording voice mail greeting:
1. Highlight the greeting you want.
2. Click Record.
3. Pick up the handset and record your own personal greeting.
4. Click Stop to stop the recording.

Playing voice mail greeting:
1. Highlight the greeting you want.
2. Click Play.
3. Check your personal greeting text and rerecord it it if necessary.

Activating the voice mail greeting:
1. Highlight the greeting you want.
2. Click Activate.
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Notification profiles
You want to specify on an individual basis how you are to be notified in 
each case. Assign a notification profile to the presence profile. You can 
activate notification profiles for Notification, Display, Audio.

Renaming the voice mail greeting:
1. Highlight the greeting you want.
2. Click Rename.
3. Enter a new name and press enter to confirm.

Deleting a voice mail greeting:
1. Highlight the greeting you want.
2. Click Delete.
3. Answer Yes to the security question.

Setting Description

Notification profile You have to indicate in a notification profile whether 
and how to be notified about a specific event. The var-
ious events are assigned information destinations. 
You can, for instance, specify that an e-mail should be 
generated after an unanswered call.

Display profile A display profile is used to determine how an event 
will be displayed on the phone based on its priority.

Audio profile The phone ring tone signals, as well as the loud-
speaker and handset speaker volume, are set in an 
audio profile.

 Configuring a notification profile (Notification tab):
Open the Configuration.

Select the Profile dialog box.

Select the Notification tab.

In the Notification field, click the Configurations button.
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Creating a new notification profile:
1. Click New .
2. Enter a new name and confirm with OK.
3. Click "Add" to define the source and destinations.
4. Save with Apply.

Notes: The source/destinations configuration can be found in the chapter "Creating a 
new source profile:", page 114 or "Creating a new destination profile:", 
page 115.

Copying notification profiles:
1. Highlight the notification profile you want.
2. Click Copy .
3. Enter a new name and confirm with OK.
4. Save with Apply.

Deleting a notification profile:
1. Highlight the notification profile you want.
2. Click Delete .
3. Answer Yes to the security question.

Notes: • These functions are also accessible via the context menu of the right mouse 
key.

• You cannot modify or delete default profiles.

Configuring sources (Notification tab):
Open the Configuration.

Select the Profile dialog box.

Select the Notification tab.

In the Notification field, click the Configurations button.

Creating a new source profile:
1. Click Configure sources.
2. Click New .
3. Enter a new name and confirm with OK.
4. Click Add.
5. Select the event (source type) that should trigger a notification.
6. Click  then confirm your settings with OK.
7. Save with Apply.
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Copying a source profile:
1. Highlight the source profile you want.
2. Click Copy .
3. Enter a new name and confirm with OK.

Deleting a source profile:
1. Highlight the source profile you want.
2. Click Delete .
3. Answer Yes to the security question.

Notes: • These functions are also accessible via the context menu of the right mouse key.
• You cannot modify or delete default profiles.

Configuring destinations (Notification tab):
Open the Configuration.

Select the Profile dialog box.

Select the Notification tab.

In the Notification field, click the Configurations button.

Creating a new destination profile:
1. Click Configure destinations.
2. Click New .
3. Enter a new name and confirm with OK.
4. Click Add.
5. Select the event (destination type) that should trigger a notification.
6. Click  then confirm your settings with OK.
7. Save with Apply.

Copying a destination profile:
1. Highlight the destination profile you want.
2. Click Copy .
3. Enter a new name and confirm with OK.

Deleting a destination profile:
1. Highlight the destination profile you want.
2. Click Delete .
3. Answer Yes to the security question.

Notes: • These functions are also accessible via the context menu of the right mouse key.
• You cannot modify or delete default profiles.
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 Configuring display profiles (Display tab):
Open the Configuration.

Select the Profile dialog box.

Select the Notification tab.

In the Display field, click the Configurations button.

Creating a new display profile:
1. Click New .
2. Enter a new name and confirm with OK.
3. Define the action display priority on the phone:
4. Save with Apply.

Copying display profile:
1. Highlight the audio profile you want.
2. Click Copy .
3. Enter a new name and confirm with OK.
4. Save with Apply.

Deleting a display profile:
1. Highlight the audio profile you want.
2. Click Delete .
3. Answer Yes to the security question.

Notes: • These functions are also accessible via the context menu of the right mouse 
key.

• You cannot modify or delete default profiles.

 Configuring an audio profile (Audio tab):
Open the Configuration.

Select the Profile dialog box.

Select the Notification tab.

In the Audio field, click the Configurations button.
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 Notifications
You can configure your system in such a way that you are notified by e-
mail about certain events or that calendar inputs are displayed on your 
phone's screen.

Creating a new audio profile:
1. Click New .
2. Enter a new name and confirm with OK.
3. Save with Apply.

Copying an audio profile:
1. Highlight the audio profile you want.
2. Click Copy .
3. Enter a new name and confirm with OK.
4. Save with Apply.

Deleting an audio profile:
1. Highlight the audio profile you want.
2. Click Delete .
3. Answer Yes to the security question.

Notes: • These functions are also accessible via the context menu of the right mouse 
key.

• You cannot modify or delete default profiles.
• You cannot make any setting in the audio profiles.

Defining notifications:
In the menu bar, open the Notification menu.

Carry out the settings you want by activating the corresponding checkboxes 
then confirm with OK.
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Function profiles
A functions profile contains one or more predefined communication server 
functions. When the function profile is activated the functions are activated 
or deactivated in the sorting order. Some functions still require some addi-
tional arguments.

You can specify the profile to be activated automatically when you launch 
(On activation) or shut down (On deactivation). Assign a function profile to 
the presence profile.

The following categories and its functions are available:

Call forwardings Description

Call forw. (CFU) to user Incoming calls are automatically forwarded to a spe-
cific destination.

Call forw. (CFU) to text 
message

Incoming calls are automatically forwarded to a spe-
cific destination.

Call forw. (CFU) to pager Incoming calls are automatically forwarded to a spe-
cific destination.

Call forw. (CFU) to VM Incoming calls are automatically forwarded to a spe-
cific destination.

Call forw. if busy (CFB) to 
user

If you are busy, incoming calls will be forwarded to 
specific destination (user).

Call forw. if busy (CFB) to 
VM

If you are busy, incoming calls will be forwarded to 
specific destination (voice mail).

Call forw. on no reply 
(CFNR) to user

Incoming calls are also forwarded to another desti-
nation (user).

Call forw. on no reply 
(CFNR) to pager

Incoming calls are also forwarded to another desti-
nation (pager).

Call forw. on no reply 
(CFNR) to VM

Incoming calls are also forwarded to another desti-
nation (voice mail).

Do not disturb Your phone does not ring and is set to busy for 
incoming calls. Incoming calls are automatically for-
warded to a destination that has been configured by 
your system administrator.

Note: For more information about call forwarding, refer to 
chapter "Call Forwardings", page 62.
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Protection:

Call waiting protection If you enable this protection, you will not receive any 
optical (display) or acoustic (call waiting tone) signal 
that another user wishes to talk to you while you are 
already busy with a call.

Call intrusion protection If you activate this protection, it is not possible for a 
third user to intrude on your active call and listen in 
to your conversation.

Announcement protection If you enable this protection, internal users cannot 
speak to you directly via your loudspeaker, that is 
without first waiting for an answer from you.

CFU protection If you enable this protection, incoming calls cannot 
be forwarded directly to your phone.

Fast take protection If you have activated this protection, you cannot 
take an incoming call or an active call from another 
phone to your phone.

Remote control protection If you enable this protection, no configuration 
adjustments can be made through remote mainte-
nance but only locally on your phone.

Note: For more information about protection, refer to 
chapter "Protection", page 104.

Record malicious call 
(MCID)

Track malicious call: Your are being threatened or 
molested by a call. You want to identify the caller. 
Using the MCID: Malicious Call Identification func-
tion the provider records the following call data: Your 
phone number, the caller’s phone number, and the 
time and date of the call. MCID has to be enabled by 
your provider. Your provider will inform you about 
accessing the recorded call data.

Hide number on/off Prevent your call number permanently from being 
displayed to the caller.

Call number per call Prevent your call number once from being displayed 
to the caller.
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Telephony functions:

Dial phone number You can dial a preconfigured call number by click-
ing.

Set up conference Set up a conference with two call parties.
For further information, please see "Making a con-
ference call", page 58.

Announcement to user Speak directly to an internal user via the loud-
speaker - where available - without them having to 
first pick up the call. An announcement is then made 
without call signal on and without call confirmation 
from the destination phone.

Announcement to group Speak directly to a defined group of internal users 
via the loudspeaker - if available - without these 
users first taking the call. An announcement is then 
made without call signal on and without call confir-
mation from the destination phone. Announcement 
groups will be defined by your system administrator.

Fast Take (pick up a call) Take an active call from another phone or a call 
coming in on  another phone on your phone. Fast 
Take must be enabled. Contact your system admin-
istrator for more information.

Deflect while ringing Deflect an incoming call to another user during the 
call phase.
For further information, please see "Deflect a call 
during the ringing phase", page 51.

Park You would like to keep the person you are talking to 
on hold without blocking a phone line.
For further information, please see "Parking a call 
partner", page 56.

Server operations:

Welcome announcement Announcement service for incoming internal and 
external calls. If you do not answer an external call 
after a set delay, the user who is calling will obtain 
an announcement. After the announcement the 
caller will then hear the ring-back tone again.

Substitution You can forward calls directed at your PC operator 
console to a preconfigured destination during your 
absence. This function is available if the system 
phone to be controlled is configured as operator 
console. For further information, please see "Substi-
tution", page 44.
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User group: Log in/out Log in/out of a user group. In the user group incom-
ing and internal calls are routed to a group of inter-
nal destinations according to a preconfigured call 
distribution.

User group all: Log in/out Log in/out of all user groups. In the user group 
incoming and internal calls are routed to a group of 
internal destinations according to a preconfigured 
call distribution.

Home Alone If calls to a user group can only be answered by one 
user, the user in question can activate Home Alone 
on the user group. Then if the user is already in a 
call, all subsequent internal or external calls to the 
user group obtain a busy tone.

User alarm Generates one event message.

• Macro: with state
• Macro: stateless

You can enter a function command directly with this 
function.

Call recording: Start/stop Record a call. The recordings are backed up only in 
your individual e-mail boxes.

Call center:

Agent login Activate/deactivate login function.

Agent pause Activate/deactivate pause function.

Agent wrap up time Activate/deactivate wrap up time function.

Other applications:

Voice mail greeting Activates/deactivates a selected voice mail greet-
ing. For further information, please see "Managing 
personal voice mail greetings", page 112.

Redkey: Trigger Actuating a redkey triggers the function configured 
on the connected third-party system. Contact your 
system administrator for more information.

Profile switch You can use the profile switch to activate and deac-
tivate presence profiles according to the 
MiVoice 1560 presence status. For further informa-
tion, please see "Profile switch", page 108.

Server operations:
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Configuring function profiles:
Open the Configuration.

Select the Profile dialog box.

Select the Functions tab.

Select the relevant action (On Activation or On Deactivation) and click the Con-
figuration button.

Creating a new function profile:
1. Click on .
2. Enter a new name and confirm with OK.
3. Save with Apply.

Notes: The functions configuration can be found in the chapter "Configuring functions:", 
page 122.

Copying function profile:
1. Highlight the function profile you want.
2. Click on .
3. Enter a new name and confirm with OK.
4. Save with Apply.

Deleting a function profile:
1. Highlight the function profile you want.
2. Click on .
3. Answer Yes to the security question.

Notes: • These functions are also accessible via the context menu of the right mouse 
key.

• You cannot modify or delete default profiles.

Configuring functions:
Open the Configuration.

Select the Profile dialog box.

Select the Functions tab.

Select the relevant action (On Activation or On Deactivation) and click the Con-
figuration button.
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Function commands
You can store some functions on a configurable key with the help of the 
predefined selection. You can also write some functions yourself using 
some function commands and function codes. The function commands are 
listed here, the function codes are contained in the user's guide “Features 
Overview Mitel 415/430/470” on the Mitel DocFinder.

You can use function commands to define a function to suit your personal 
requirements. A function can consist of one or more function commands, 
function codes, and the phone number.  You can either carry out a function 
directly or store it under a key.

Add function:
1. Highlight the function profile you want.
2. Click Add.
3. Select the category and function you want.
4. Activate or deactivate the function then confirm with OK.
5. Save with Apply.

Modifying a function:
1. Highlight the function profile you want.
2. Highlight the function you want.
3. Click Modify.
4. Enter the settings you want and click OK to confirm.
5. Save with Apply.

Deleting a function:
1. Highlight the function profile you want.
2. Highlight the function you want.
3. Click Remove.
4. Save with Apply.

The following function commands are available (depending on the connected 
phone):

"A" Seize line with highest priority

"I" Seize line

"H" Seize line in hands-free mode

"X" Disconnect call connection

"P" Pause 1 second before the next operation

"Lxx" Seize line xx (Line keys)
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Function codes
You will find a list of all function codes in the user guide “Features Over-
view Mitel 415/430/470” on the Mitel DocFinder.

"N" Use the phone number entered in call preparation

"." Control keys function

"Z" Activate/deactivate DTMF mode

"R" Use the phone number last dialled

"Y" Disconnect call and reseize the line

Examples of how to define a function:

"IR" Seize line ("I"),
Dial phone number last dialled ("R")

"I201" Seize line ("I") and dial phone number 201

"I*21201X" Seize line ("I"), 
activate call forwarding unconditional ("*21") to phone number 
201,
Disconnect call connection ("X")

Notes: • Functions that are not available via the menu can be acti-
vated using function codes (see user guide “Features Over-
view Mitel 415/430/470” on the Mitel DocFinder) aktivieren.

• You can either type in a function command or code directly or 
store it under a function key.

• You can only activate certain function codes if the same func-
tion cannot be obtained via the menu.

• The availability of certain function codes may be restricted 
depending on the system and software version.

The following function commands are available (depending on the connected 
phone):
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– by name  . . . . . . . . . . . . . . . . . . . . . . . 52
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– with phone number . . . . . . . . . . . . . . . 51
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Display symbols:
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– phone  . . . . . . . . . . . . . . . . . . . . . . . . . 26
– Presence status  . . . . . . . . . . . . . . . . . 72

Display:
– calendar entry . . . . . . . . . . . . . . . . . . . 82

Do not disturb . . . . . . . . . . . . . . . . . . . . 104
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E-Mail connection . . . . . . . . . . . . . . . . . . 49
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– call (queue) . . . . . . . . . . . . . . . . . . . . . 45

Enquiry call during a call . . . . . . . . . . . . . 56

External display  . . . . . . . . . . . . . . . . . . . 30
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– phone book . . . . . . . . . . . . . . . . . . . . . 96

Forward  . . . . . . . . . . . . . . . . . . . . . . . . . 51

Function codes . . . . . . . . . . . . . . . . . . . 124
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– add  . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
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– modify . . . . . . . . . . . . . . . . . . . . . . . . . 78
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G
Group announcement see: Announcement 61
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– User  . . . . . . . . . . . . . . . . . . . . . . . . . . .71

K
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L
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